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I. ИШЧИ ДАСТУР 

Кириш 

 

Ўзбекистоннинг келажаги, унинг истиқболи, биринчи навбатда ёшлар 

тарбиясига, уларни соғлом қилиб ўстиришга, миллий ғоя, миллий мафкура ва 

ўз ватанига садоқат руҳида тарбиялашга боғлиқ бўлиб, бу мураккаб жараённи 

муваффақиятли амалга ошириш мустақил мамлакатнинг энг долзарб 

вазифаларидан биридир. Шунинг учун ҳам,  биринчи Президентимиз Ислом 

Абдуғаниевич Каримовнинг “Мамлакатимизнинг истиқболли ёш 

авлодларимиз қандай тарбия топишига, қандай маънавий фазилатлар эгаси 

бўлиб вояга етишига,  фарзандларимизнинг ҳаётга нечоғлик  фаол муносабати 

бўлишига, қандай олий мақсадларга хизмат қилишига боғлиқ эканлигини 

ҳамиша ёдда тутишимиз керак” деб таъкидлагани бежиз эмас.  Шу боисдан 

ҳам бугунги кунда ёшларнинг таълим тарбияси мустақил Ўзбекистоннинг 

давлат сиёсатида устивор аҳамият касб этмоқда.  

Ўзбекистон Республикаси Президенти Шавкат Мирзиёевнинг 

мамлакатимизни 2016 йилда ижтимоий – иқтисодий ривожлантиришнинг 

асосий якунлари ва 2017 йилга мўлжалланган иқтисодий дастурнинг энг 

муҳим устивор йўналишларига бағишланган Вазирлар маҳкамасининг 

кенгайтирилган мажлисидаги маърузасида ёшларимиз, жамиятимиз ва 

мамлакатимизнинг келажаги учун стратегик аҳамиятга эга эканини айтиб, 

таълим ва илм фан, таълимнинг янги, замонавий усулларини, жумладан, 

ахборот коммуникация технологияларини жорий этиш соҳасида долзарб 

вазифаларни белгилаб берди. Олий ўқув юртларида илм-фанни янада 

ривожлантириш, илмий муассасаларнинг моддий-техник базасини илғор 

хорижий марказлар даражасида ва олимлар талабларига мувофиқ сезиларли 

даражада мустаҳкамлашдан иборат эканлигини таъкидлаб ўтдилар. 

Ҳозирги кунда ҳаётимизга тобора сингиб, амалга оширилаётган “2017-

2021-йилларда Ўзбекистон Республикасини ривожлантиришнинг бешта 

устувор йўналиши бўйича Ҳаракатлар стратегияси”нинг “Давлат ва жамият 

қурилишини такомиллаштириш” деб номланган биринчи йўналишида 

“Электрон ҳукумат” тизимини янада ривожлантириш, “Иқтисодиётни янара 

ривожлантириш ва либераллаштириш” деб номланган учинчи йўналишида 

замонавий технологияларни жорий этиш, “Ижтимоий соҳани 

ривожлантириш” деб номланган тўртинчи йўналишида таълим сифатини 

яхшилаш ҳамда уларни ривожлантириш чора-тадбирларини амалга ошириш 

назарда тутилган. 

Ҳозирда Республикамизда иқтисодиёт тармоқларига замонавий ахборот-

коммуникация технологияларини кенг тадбиқ этиш, «Электрон ҳукумат» 

тизими фаолиятини янада ривожлантириш жадал суръатларда амалга 

оширилмоқда. Хусусан, таълим тизимида ҳам барча олий таълим 

муассасаларида Moodle тизимининг жорий этилиши, иш юритиш 

ҳужжатларининг электрон шаклга ўтказилаётгани яқин йиллар ичида таълим 

тизимида кескин ўзгаришлар бўлишидан далолат беради. Педагогик 



6 
 

кадрларни қайта тайёрлаш ва малакасини ошириш тармоқ марказларида 

"Таълим жараёнида ахборот-коммуникация технологияларини қўллаш" 

модулининг ўқитилиши эса профессор-ўқитувчиларнинг бу технологияларни 

олдиндан тез ўзлаштириб олишларига замин яратади. 

Мазкур дастурнинг мақсади олий таълим муассасалари педагог 

кадрларининг махсус фанларни ўқитишда Moode масофавий таълим тизими 

учун ҳамда келгусида blended learning (аралаш ўқитиш) тизимлари учун 

интерактив мультимедиа материаллари ишлаб чиқиш бўйича касбий 

тайёргарлик даражасини янада такомиллаштиришдир. 

Дастур мазмунида мультимедиа материалларини ишлаб чиқиш, 

хусусан, технологик фанлар учун Flash анимациялар ва симуляторлар 

яратиш бўйича зарур билимлар акс эттирилган. 

 

Модулнинг мақсади ва вазифалари 

“Технологик фанлар учун Flash анимациялар ва симуляторлар ишлаб 

чиқиш” модулининг мақсади:   

- педагог кадрларни қайта тайёрлаш ва малака ошириш курс 

тингловчиларини технологик фанларини ўқитишдаги мультимедиа 

маҳсулотлари ва уларнинг дастурий воситалари; 

- мультимедиа маҳсулотларининг таълимдаги самараси; 

- Flash дастурининг график, анимацион ва дастурлаш имкониятлари 

ҳақидаги билимларини такомиллаштиришга қаратилган. 

“Технологик фанлар учун Flash анимациялар ва симуляторлар ишлаб 

чиқиш” модулининг вазифалари: 

- мультимедиа маҳсулотлари, ҳусусан анимациялар ва 

симуляторларнинг таълимдаги самарасини;  

- Flash дастурининг график, анимацион ва дастурлар имкониятларини; 

- мультимедиа сценарийларини ишлаб чиқишни;  

- Flash анимациялар ишлаб чиқиш усулларини;  

- Flash дастурида технологик фанларнинг амалий ва лаборатория 

машғулотлари учун симуляторлар ишлаб чиқишни ўрганишдир.  

 

Модул бўйича тингловчиларнинг билими, кўникмаси, малакаси ва 

компетенцияларига қўйиладиган талаблар 

“Технологик фанлар учун Flash анимациялар ва симуляторлар ишлаб 

чиқиш” модулини ўзлаштириш жараёнида амалга ошириладиган масалалар 

доирасида тингловчилар: 

- Flash дастури, унинг имкониятлари, анимация ва симуляторлар 

яратишда қўлланиладиган элементлар ва усулларни билиши;  

- мультимедиа сценарийсини тузиш ва унинг асосида мультимедиа 

материалларини ишлаб чиқиш,  мультимедианинг дастурий воситаларидан 

фойдаланиш, Moodle тизими учун мультимедиали контентларни 

шакллантириш каби кўникмаларга эга бўлиши; 

- интернет тармоғида мавжуд электрон ахборот ресурсларидан ва 

масофавий таълим тизимлари имкониятларидан фойдаланиш, оммавий очиқ 
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онлайн курсларида ўқиб билим олиш  малакаларини эгаллаши; 

- мутахассислик фанлари бўйича машғулотларни ташкил этишда 

мультимедиа воситаларидан самарали фойдаланиш, улар орқали касбий 

маҳоратини ва иқтидорини намоён қилиш компетенцияларига эга бўлиши 

лозим. 

 

Модулни ташкил этиш ва ўтказиш бўйича тавсиялар 

“Технологик фанлар учун Flash анимациялар ва симуляторлар ишлаб 

чиқиш” модули  маъруза ва амалий машғулотлар шаклида олиб борилади. 

Модулни ўқитишда таълимнинг замонавий методлари, ахборот-

коммуникация технологияларидан фойдаланиш назарда тутилган: 

- маъруза дарсларида замонавий компьютер технологиялари ёрдамида 

тақдимотлар ва электрон-дидактик воситалардан фойдаланиш; 

- амалий машғулотларда компьютер техникаси, Интернет тизими, 

график органайзерлар, интерфаол ўқитиш усулларидан фойдаланиш назарда 

тутилади. 

 

Модулнинг ўқув режадаги бошқа модуллар билан боғлиқлиги ва 

узвийлиги 

Мазкур модуль ўқув режадаги “Инновацион таълим технологиялари ва 

педагогик компетентлик”, “Технологик фанларни ўқитишда илғор хорижий 

тажрибалар”, “Электрон педагогика асослари ва педагогнинг шахсий, касбий 

ахборот майдонини лойиҳалаш” ўқув модуллари билан узвий боғланган ҳолда 

тингловчиларнинг касбий педагогик тайёргарлик даражасини орттиришга 

хизмат қилади.  

 

Модулнинг олий таълимдаги ўрни 

Фан ўқитувчиларининг ўқув жараёнини замонавий услубда самарали 

ташкил этишлари учун “Технологик фанлар учун Flash анимациялар ва 

симуляторлар ишлаб чиқиш” модули  катта аҳамиятга эга. 

 

Модул  бўйича соатлар тақсимоти 

 

№ 

 
Модул мавзулари 

Тингловчининг ўқув юкламаси, соат 

Ҳам-

маси 

Аудитория ўқув 

юкламаси 
Мус-

тақил 

таъ-

лим 
Жа-

ми 

жумладан 

Наза

рий 

Амалий 

машғулот 

1. Flash анимациялар ишлаб чиқиш 6 4 2 2 2 

2. Flash дастурида интерактив 

симуляторлар ишлаб чиқиш 

8 6 2 4 2 

 Жами: 14 10 4 6 4 
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НАЗАРИЙ  МАШҒУЛОТЛАР МАЗМУНИ 
 

1-маъруза: Flash анимациялар ишлаб чиқиш. 

Flash дастури ҳақида. Flash дастурининг график, анимацион, видео ва 

овоз имкониятлари. Flash анимация яратиш. Технологик фанлар бўйича 

анимация сценарийсини ишлаб чиқиш. 
 

2-маъруза: Flash дастурида интерактив симуляторлар ишлаб чиқиш. 

Flash дастурининг интерфаол элементлари. Скрипт ёзиш. Flash 

дастурида интерфаол симулятор яратиш. Технологик фанлар бўйича 

симулятор сценарийсини ишлаб чиқиш. 

 

АМАЛИЙ МАШҒУЛОТЛАР МАЗМУНИ 
 

1-амалий машғулот: Flash дастури имкониятларини ўрганиш. 

Flash дастури билан танишиш. График график имкониятларни ўрганиш. 

Анимацион имкониятларни ўрганиш. Дастурлаш имкониятларини ўрганиш.  
 

2-амалий машғулот: Технологик фанлар бўйича анимациялар яратиш. 

Технологик фанлар бўйича анимация яратиш учун таълим 

натижаларини ифодалаш. Таълим натижалари асосида сценарий ишлаб 

чиқиш. Анимациялар яратиш. 
 

3-амалий машғулот: Технологик фанлар бўйича симуляторлар яратиш. 

Технологик фанлар бўйича симулятор яратиш учун таълим 

натижаларини ифодалаш. Интерактивликни режалаштириш ва сценарий 

ишлаб чиқиш. Симулятор яратиш. 

 

МУСТАҚИЛ ИШНИ ТАШКИЛ ЭТИШ ШАКЛИ ВА МАЗМУНИ 
 

Мустақил таълим тегишли ўқув модули бўйича ишлаб чиқилган 

топшириқлар асосида ташкил этилади ва унинг натижасида тингловчилар 

битирув ишини тайёрлайди.  

Тингловчилар анимацияларни яратиш Macromedia Flash MX дастурининг 

имкониятларини ўрганишади. Виртуал стендлар ва ўқув тренажёрларини 

яратиш бўйича Macromedia Flash MX дастурида симулятор яратиш 

имкониятларини ўрганишади. 

Битирув иши (лойиҳа иши) талаблари доирасида ҳар бир тингловчи ўзи 

дарс бераётган фани бўйича электрон ўқув модулларининг тақдимотини 

тайёрлайди, бунда албатта Macromedia Flash MX дастурида яратилган 

анимация ёки симуляторлар бўлиши зарур. 

Ҳар бир тингловчи битирув иши доирасида ўзи дарс бераётган фани 

бўйича Flash анимациялар ва симуляторлар ишлаб чиққан бўлиши ва уларнинг 

тақдимотини қилиши керак бўлади.  

Ишлаб чиқилган ўқув модулларида фанни ўзлаштиришга ёрдам берувчи 

қўшимча материаллар: электрон таълим ресурслари, маъруза матни, видео 
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ресурслар, глоссарий, тест, кроссвордлари ва бошқалар мавжуд бўлиши 

мумкин. Бу материалларни соҳа бўйича оммавий онлайн очиқ курсларидан 

олиш тавсия этилади. 

 

ЎҚИТИШ ШАКЛЛАРИ 
 

Мазкур модул бўйича қуйидаги ўқитиш шаклларидан фойдаланилади: 

- маъруза машғулотларида маълумотларни етказиш учун академик маъруза, 

фронтал сўров, SWOT таҳлил, ФСМУ, Инсерт, тушунчалар таҳлили, Венн 

диаграммаси методларидан фойдаланилади; 

- амалий машғулотларда ақлий қизиқишни ривожлантириш ва назарий 

билимларни мустаҳкамлаш ва назорат қилиш учун SWOT таҳлил, кейс-

стади, Ассесмент, методларидан фойдаланилади; 

- мустақил ишларда таклиф бериш, идрок қилиш ва мантиқий хулосалар 

чиқариш, лойиҳалар ечими бўйича далиллар ва асосли аргументларни 

тақдим қилиш қобилиятини ривожлантириш учун амалий топшириқлардан 

фойдаланилади. 

 

БАҲОЛАШ МЕЗОНИ 
 

Модуль бўйича таълим натижалари ассесмент усулида баҳоланади. 

Ассесмент саволи ўз ичига 4 та баҳолаш турини қамраб олади. Қуйида 

уларнинг ҳар бири учун баҳолаш мезонлари келтирилган. 

 

№ 
Баҳолаш 

турлари 

Мак-

симал 

балл 

Изоҳ 

1 Кейс-стади 1 

Кейс муаммосини тўғри тушуниш, таҳлил қилиш, 

муҳокамада фаол иштирок этиш, тўғри ечимга келиш 

даражаси баҳоланади. 

2. 
Тушунча 

таҳлили 
0,5 

Тушунчаларни қисқа, лўнда ва аниқ ифодалаши, тўғри изоҳ 

бериши, оғзаки ва ёзма нутқининг равонлиги, илмий баён 

қилиш усули, таянч атамалардан фойдаланиш даражаси 

баҳоланади. 

3. 
Қиёсий 

таҳлил 
0,5 

Материални таҳлил қилиши, янги маълумотни синтез 

қилиши, тўғри қарор қабул қилиши, жавобни график 

органайзерлар орқали ифодалаши, ўхшаш ва фарқли, 

ижобий ва салбий жиҳатларини кўрсатиб берганиши 

баҳоланади. 

4. 
Амалий 

топшириқ 
0,5 

Топшириқларни тўғри ечиши, жиҳозлардан фойдалана 

олиши, формулаларни тўғри қўллаш малакалари 

баҳоланади. 

 Жами: 2,5*  

 

*Ўзбекистон Республикаси Вазирлар Маҳкамаси ҳузуридаги 

Идоралараро комиссиянинг 2015 йил 3-ноябрдаги 2-сон мажлиси баёни 

иловасига мувофиқ ассемент учун "3. Таълим жараёнларида ахборот-

коммуникация технологияларини қўллаш" модулига 2,5 балл ажратилади. 
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II. МОДУЛНИ   ЎҚИТИШДА   ФОЙДАЛАНИЛАДИГАН    
ИНТЕРФАОЛ   ТАЪЛИМ   МЕТОДЛАРИ 

“SWOT-таҳлил” методи. 

Методнинг мақсади: мавжуд назарий билимлар ва амалий 

тажрибаларни таҳлил қилиш, таққослаш орқали муаммони ҳал этиш 

йўлларини топишга, билимларни мустаҳкамлаш, такрорлаш, баҳолашга, 

мустақил, танқидий фикрлашни, ностандарт тафаккурни шакллантиришга 

қаратилган.  

 
 

Намуна:  Macromedia Flash MX дастури учун SWOT таҳлилини амалга 

оширинг. 

S 

Кучли 

томон-

лари 

 кадр анимациялари билан ишлаш, графикани таҳрирлаш, скриптлардан 

фойдаланиш, маҳсулотни турли форматларда чоп қилиш мумкин;  

 дастурдан эркин фойдаланиш ва тарқатиш мумкин;  

 Интернетдаги флешерлар мактаби намуналаридан ўрганиш мумкин;  

 мутахассислик фанлари бўйича оригинал ва юксак савиядаги 

мультимедиа материалларини яратиш мумкин. 

W 

Кучсиз 

томон-

лари 

 мультимедиа маҳсулоти билан ишлаганда натижаларни сақлаб бўлмайди; 

 дастурда ишлаш мураккаб, профессионал маслаҳатчилар етишмайди; 

 мультимедиа учун пухта сценарий тузиш зарур; 

 html5 (мобиль алоқа воситалари учун) ва шу каби замонавий форматларда 

ишлаб бўлмайди. 

O 

Имко-

ният-

лари 

(ички) 

 натижаларни сақлашда оператив хотира имкониятларидан ва кодли-

матнли сақлаш ва киритиш усулидан фойдаланиш мумкин; 

 маҳсулотни мобил алоқа воситаларига мослаштириш учун Adobe Flash га 

конвертациялаб ишлатиш мумкин. 

T 

Тўсиқ-

лар 

(ташқи) 

 дастур мураккаб бўлганлиги сабабли оммавий тадбиқ қилиб бўлмайди 

(масалан, PowerPoint каби); 

 истеъмолчилар бозори шаклланмаган; 

 бошқа дастурларга конвертациялаш қийин. 

Strength

кучли 
томонлари

Opportunity

имкониятлари 
(ички)

Threat 
тўсиқлар 
(ташқи)

Weakness
заиф, кучсиз 
томонлари
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“Кейс-стади” методи 

«Кейс-стади» - инглизча сўз бўлиб, («case» – аниқ вазият, ҳодиса, «stadi» 

– ўрганмоқ, таҳлил қилмоқ) аниқ вазиятларни ўрганиш,  таҳлил қилиш асосида 

ўқитишни амалга оширишга қаратилган метод ҳисобланади.  Кейсда  очиқ 

ахборотлардан ёки аниқ воқеа-ҳодисадан вазият сифатида таҳлил учун 

фойдаланиш мумкин.  

Кейс. Flash MX дастурида виртуал стенд ишлаб чиқиш жараёнида 

скрипт ёзишда хатолик рўй берди. Яъни дастур тўлиқ ишламади. 

 

 
 

«ФСМУ» методи 

Технологиянинг  мақсади: Мазкур технология иштирокчилардаги 

умумий фикрлардан хусусий хулосалар чиқариш, таққослаш, қиёслаш орқали 

ахборотни ўзлаштириш, хулосалаш, шунингдек, мустақил ижодий фикрлаш 

кўникмаларини шакллантиришга хизмат қилади. Мазкур технологиядан 

маъруза машғулотларида, мустаҳкамлашда, ўтилган мавзуни сўрашда ҳамда 

амалий машғулот натижаларини таҳлил этишда фойдаланиш тавсия этилади.  

Технологияни   амалга ошириш тартиби: 

 қатнашчиларга  мавзуга оид якуний хулоса ёки ғоя таклиф этилади; 

 ҳар бир иштирокчига ФСМУ технологиясининг босқичлари ёзилган 

қоғозларни тарқатилади: 

 иштирокчиларнинг муносабатлари индивидуал ёки гуруҳий тартибда 

тақдимот қилинади. 

 
ФСМУ  таҳлили  қатнашчиларда касбий-назарий билимларни амалий 

машқлар ва мавжуд тажрибалар асосида тезроқ ва муваффақиятли 

ўзлаштирилишига асос бўлади. 

• Кейсдаги муаммони келтириб чиқарган асосий сабабларни
белгиланг, зарур билимлар рўйхатини тузинг (индивидуал ва
кичик гуруҳда).

• Дастурдаги хатоликни йўқотиш учун бажариладагина ишлар
кетма-кетлигини белгиланг (жуфтликда ишлаш).

• Хатоликни тузатинг ва дастурни ишга туширинг.

• Бажарилган ишларни тақдимот қилинг.

Кейсни бажариш босқчилари ва топшириқлар:

Ф
фикрингизни 

баён этинг

С
фикрингизни 

баёнига 
сабаб 

кўрсатинг

М
кўрсатган  

сабабингизга 
мисол 

келтиринг

У
фикрингизни 

умумлаш-
тиринг 
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Намуна: Қуйидаги фикрни ФСМУ орқали таҳлил қилинг. 

ФИКР: “Flash MX дастурида амалий машғулотлар учун виртуал 

стендлар ишлаб чиқиш мумкин”. 

САБАБ: “Flash MX дастурида амалий машғулот виртуал стендини 

ишлаб чиқишда ҳисоб ишларини бажаришда қўллаш мумкин бўлган турли 

функциялар мавжуд”. 

МИСОЛ: “Flash MX дастурида форматлаш функциясидан фойдаланиб 

ҳисоблаш натижаларини форматлаш мумкин”. 

УМУМЛАШТИРИШ: "Flash MX дастурида амалий машғулотлар учун 

виртуал стенд ишлаб чиқишда форматлаш функциясидан фойдаланиш 

мумкин". 

 

“Ассесмент”  методи 

Методнинг мақсади:  мазкур метод таълим олувчиларнинг билим 

даражасини  баҳолаш, назорат қилиш, ўзлаштириш кўрсаткичи ва амалий 

кўникмаларини текширишга йўналтирилган.  Мазкур техника орқали таълим 

олувчиларнинг  билиш  фаолияти турли  йўналишлар (кейс-стади, амалий 

топшириқлар, қиёсий таҳлил, симптомларни аниқлаш) бўйича ташҳис 

қилинади ва баҳоланади.  

Методни амалга ошириш тартиби: 

“Ассесмент” лардан  маъруза машғулотларида талабаларнинг ёки 

қатнашчиларнинг мавжуд билим даражасини ўрганишда, янги маълумотларни 

баён қилишда, семинар,  амалий машғулотларда эса мавзу ёки маълумотларни 

ўзлаштириш даражасини баҳолаш, шунингдек, ўз-ўзини баҳолаш мақсадида 

индивидуал шаклда  фойдаланиш тавсия этилади.  

Намуна. Ҳар бир катакдаги тўғри жавоб алоҳида баллар билан 

баҳоланиши мумкин. 

 
 

1. Кейс-стади 
Flash MX дастурида виртуал 
стенд ишлаб чиқиш 
жараёнида скрипт ёзишда 
хатолик рўй берди. Яъни 
дастур тўлиқ ишламади. 
Муаммони ҳал қилинг. 

Қиёсий таҳлил 

M
a
c
r
o
m

Тушунча таҳлили 

M
o
t
i
o
n

Амалий кўникма 

Лаборатори иши учун 
виртуал стенднинг 
сценарийсини ишлаб 
чиқинг. 
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“Инсерт” методи 

 Методнинг мақсади: Мазкур метод ўқувчиларда янги ахборотлар 

тизимини қабул қилиш ва билимларнинг ўзлаштирилишини енгиллаштириш 

мақсадида қўлланилади, шунингдек, бу метод ўқувчилар учун хотира машқи 

вазифасини ҳам ўтайди. 

Методни амалга ошириш тартиби: 

 ўқитувчи машғулотга қадар мавзунинг асосий тушунчалари мазмуни 

ёритилган инпут-матнни тарқатма ёки тақдимот кўринишида тайёрлайди; 

 янги мавзу моҳиятини ёритувчи матн таълим олувчиларга  

тарқатилади ёки тақдимот кўринишида намойиш  этилади; 

 таълим олувчилар  индивидуал тарзда матн билан танишиб чиқиб, ўз 

шахсий қарашларини тегишли сўзларнинг остига чизиб ёки чизмасдан, махсус  

белгиларни ("v" - таниш маълумот, "?" - мазкур маълумотни тушунмадим, изоҳ 

керак, "+" - бу маълумот мен учун янгилик, "-" - бу фикр ёки мазкур 

маълумотга қаршиман, "!" - жуда яхши ва ҳ.к.) варақ ҳошиясига қўйиш орқали 

ифодалайдилар. 

 

Инпут-матн Махсус 

белгилар 

Flash MX дастурида график шаклларни ясаш учун 

стандарт ҳолатда 22 хил турдаги асбоблар кeлтирилган. Properties 

созламаларида кадрлар учун фреймлар, анимациялар, овоз ва 

эффектлар билан ишлаш, шакллар билан ишлаганда ўлчамлар ва 

координаталар, шаклнинг чизиғининг тури, силлиқлиги ва 

қалинлиги, чизиқнинг ва шакл ичининг ранглари билан ишлаш 

мумкин. 

Рангларни белгилашда айнан ушбу функцияларни бошқа 

асбоблар билан ҳам бажариш мумкин. Масалан, Color Mixer 

ойнасида рангнинг RGB си ва альфаси билан, ранглар градиенти 

билан ишлаш мумкин. 

Шакл анимацияларини бажаришда кадрни ажратиб кейин 

бир шаклни бошқа шаклга автомат тарзда айлантириш мумкин.  

График материалларни ташқаридан импорт қилиб уларга 

ҳам анимация қўйиш мумкин. 

v 

 

+ 

 

! 

 

 

- 

 

? 

 

 

!+ 

 

Белгиланган вақт якунлангач,  таълим олувчилар учун нотаниш ва 

тушунарсиз бўлган маълумотлар ўқитувчи томонидан таҳлил қилиниб, 

изоҳланади,  уларнинг моҳияти тўлиқ ёритилади.  Саволларга жавоб берилади 

ва машғулот якунланади. Техник матнни инсерт усулида белгилашни амалий 

машғулотнинг уй вазифаси (мустақил иш) сифатида бериш ҳам мумкин. 

 

“Тушунчалар таҳлили” методи 

Методнинг мақсади: мазкур метод талабалар ёки қатнашчиларни мавзу 

буйича таянч тушунчаларни ўзлаштириш даражасини аниқлаш, ўз 

билимларини мустақил равишда текшириш, баҳолаш, шунингдек, янги мавзу 
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буйича дастлабки билимлар даражасини ташҳис қилиш мақсадида 

қўлланилади. 

Методни амалга ошириш тартиби: 

 иштирокчилар машғулот қоидалари билан таништирилади; 

 ўқувчиларга мавзуга ёки бобга тегишли бўлган сўзлар, тушунчалар 

номи туширилган тарқатмалар берилади ( индивидуал ёки гуруҳли тартибда); 

 ўқувчилар мазкур тушунчалар қандай маъно англатиши, қачон, қандай 

ҳолатларда қўлланилиши ҳақида ёзма маълумот берадилар; 

 белгиланган вақт якунига етгач ўқитувчи берилган тушунчаларнинг 

тўғри ва тўлиқ изоҳини ўқиб эшиттиради ёки слайд орқали намойиш этади;  

 ҳар бир иштирокчи берилган тўғри жавоблар билан ўзининг шахсий 

муносабатини таққослайди, фарқларини аниқлайди ва ўз билим даражасини 

текшириб, баҳолайди. 

Намуна: “Модулдаги таянч тушунчалар таҳлили” 

Тушунчалар 
Сизнингча бу тушунча қандай маънони 

англатади? 

Қўшимча 

маълумот 

shape tween 

Шакл формати, координатаси, ўлчамлари, 

шаффофлиги, ҳаракат тезлиги ва 

тезланиши, ҳаракатнинг такрорланиши, 

овозлари ва эффектининг ўзгариши. 

векторли 

графика 

бўлиши 

шарт 

motion tween 

График материалнинг айланиши, 

траектория бўйлаб ҳаракати, координатаси, 

ўлчамлари, шаффофлиги, ҳаракат тезлиги 

ва тезланиши, ҳаракатнинг такрорланиши, 

овозлари ва эффектининг ўзгариши. 

векторли 

графика 

учун амал 

қилмайди 

қатламлар панели 

Тасвир бўлакларини олдинма-кетин 

жойлаштириш, шакллар учун маска қўйиш, 

анимацион ҳаракат траекторияларини 

белгилаш, кўринишини яшириш, 

ҳимоялаш ва контурини кўриш учун 

хизмат қилади. 

 

Изоҳ: Иккинчи устунчага қатнашчилар томонидан фикр билдирилади. 

Мазкур тушунчалар ҳақида қўшимча маълумот глоссарийда келтирилган 

бўлиши мумкин.  

 

"Венн диаграммаси" методи 

Методнинг мақсади:  Бу метод график тасвир орқали ўқитишни ташкил 

этиш шакли бўлиб, у иккита (учта, тўртта ва ҳ.к.) ўзаро кесишган айлана 

тасвири орқали ифодаланади. Мазкур метод турли тушунчалар, асослар, 

тасавурларнинг анализ ва синтезини бир нечта аспект орқали кўриб чиқиш, 

уларнинг умумий ва фарқловчи жиҳатларини аниқлаш, таққослаш имконини 

беради. 

Методни амалга ошириш тартиби: 

 иштирокчилар икки кишидан иборат жуфтликларга бирлашадилар ва 
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уларга кўриб чиқилаётган тушунча ёки асоснинг ўзига хос, фарқли 

жиҳатларини (ёки акси) доиралар ичига ёзиб чиқиш таклиф этилади; 

 навбатдаги босқичда иштирокчилар тўрт (3-5) кишидан иборат кичик 

гуруҳларга бирлаштирилади ва ҳар бир жуфтлик ўз таҳлили билан гуруҳ 

аъзоларини таништирадилар; 

  жуфтликларнинг таҳлили эшитилгач, улар биргалашиб, кўриб 

чиқилаётган муаммо ёҳуд тушунчаларнинг умумий жиҳатларини (ёки фарқли) 

излаб топадилар, умумлаштирадилар ва доирачаларнинг кесишган қисмига 

ёзадилар. 

 

Намуна: Анимациялар яратиш имкониятлари бўйича Venn-

диаграммаси 
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III. НАЗАРИЙ МАТЕРИАЛЛАР 

1-маъруза: Flash анимациялар ишлаб чиқиш. 

Режа: 

1.1. Flash дастури ҳақида.  

1.2. Flash дастурининг график, анимацион, видео ва овоз 

имкониятлари. 

1.3. Анимациялар учун педагогик сценарийлар ишлаб чиқиш. 

 

 

Таянч иборалар: Flash MX, мультимедиа, видеоролик, виртуал стенд, 

анимация, мультимедиа сценарийси, Macromedia Flash, Adobe Flash, FLA, 

SWF, EXE, ActionScript, растрли ва векторли графика, кадрли анимация, шакл 

анимацияси, навигация элементлари, таълим натижалари. 

 

1.1. Flash дастури ҳақида 

Бугунги кунда Ўзбeкистон Рeспубликасида ахборот тeхнологияларини 

кeнг жорий этиш давлат сиёсатининг устувор йўналишларидан бирига 

айланган. Мамлакатимизнинг барча жабҳаларида, хусусан, таълим тизимида 

ҳам компьютер ва тeлeкоммуникация тeхнологиялари, дастурий таъминот 

маҳсулотларини ишлаб чиқариш соҳасининг аҳамияти тобора ортиб бораяпти. 

Ҳозирги кунда, таълим жараёнига ахборот тeхнологиялари, асосан, замонавий 

восита сифатида ва тайёр мултимeдиа матeриалларидан фойдаланган ҳолда 

тадбиқ этилмоқда. Ҳозирги давр, энди ўзимизнинг мултимeдиа 

маҳсулотларимизни ишлаб чиқишни ҳам талаб этмоқда. Зeро, китоб ёзиш – 

ижодий фаолиятнинг энг юқори чўққиси бўлса, мултимeдиали матeриаллар 

ишлаб чиқиш – унинг замонавий кўринишидир. 

Flash-анимациялар ахборот тeхнологияларининг энг қизиқарли ва 

эътиборни тортадиган мултимeдиа маҳсулотлари ҳисобланади. 

Анимацияларни яратиш учун кўплаб дастурлар мавжуд, лeкин уларнинг ичида 

Flash дастури энг унивeрсал дастур ҳисобланади. Унда ҳоҳлаган фантазияни, 

ҳоҳлаган илмий тушунчани икки ўлчамли мултипликация шаклида яратиш 

мумкин. Лeкин, у жуда мураккаб бўлиб, уни ўрганиш инсондан кўп вақтни ва 

анимациялар яратиш кучли билимни талаб этади. 

Flash иловаси рақамли мультимедиа маҳсулотлари яратиш учун 

универсал воситадир. Векторли графикага асосланган Flash технология тез 

юкланадиган анимацияни узатувчи рақамли технологиялар ичида доим илғор 

ҳисобланган. 

Мультимедиа – қурилмалар ва дастурий воситалар комплексидан иборат 

бўлиб, фойдаланувчига турли маълумотлар (овоз, видео, матн, графика ва ҳ.к.) 

билан мулоқот режимида ишлашга имкон беради. 

Macromedia Flash MX дастуридан интерфаол видеороликлар яратишда 

ёки график объектларни ясашда ҳам фойдаланиш мумкин. 

1980-йилларнинг охири ва 1990-йилларнинг бошларида  Калифорнияда 
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йирик Micromedia компанияси пайдо бўлди. У Macromind (VideoWorks 

иловасини ишлаб чиққан), Рarасоmр (Macintosh учун 3D-иловалар ишлаб 

чиққан) ва Аuthоrwаrе (Аuthоrwаrе мультимедиа иловасини ишлаб чиққан) 

компанияларнинг бирлашувидан пайдо бўлган.  

1993 йилда Micromedia компанияси FutureWave компанияси билан 

ҳамкорлик қила бошлади. FutureWave компанияси 1996 йил ёзида ўзининг 

FutureSplash Аnimаtоr деб номланган дастурини яратди. Бу илова векторли 

графика асосида чизиқли анимация яратишга мўлжалланган эди. Бу маҳсулот 

тезда Disney компаниясининг эътиборини тортди.  

1996 йилнинг декабрида Масrоmеdiа компанияси FutureWave 

компаниясидан FutureSplash технологиясини сотиб олди ва 1997 йилнинг 

бошида дастлабки Flash 1 версиясини чиқарди. 

Flash 1. Бу илова FutureSplash дастурининг номи ўзгартирилган ва 

чекланган функцияли версияси бўлган, ҳолос.У вақт шкаласидан фойдаланиб 

векторли тасвирларни анимациялаш учун мўлжалланган. Унинг асосий 

афзаллиги тармоқда анимациялар билан ишлашида эди. 

Flash 2. Бу версия олдингисидан анча такомиллашиб, оддий анимацион 

дастурдан интерфаол медиа иловага айланган эди. Бу дастурда кутубхона 

элементлари, график тасвирлар тўплами ва векторли шрифтлар, шунингдек, 

стерео овоз ҳам пайдо бўлди. Бу версия EPS, GIF, JPEG, AutoCAD DFX, ВМР, 

Enhanced Metafile, AIFF, Windows Metafile ва Shockwave форматдаги 

тасвирларни импорт қилиш имкониятига ҳам эга эди. 

Flash 3. Бу версияда ҳаракатлар такомиллаштирилди. JavaScript 

асосидаги ҳаракатлар тадбиқ этилиб фильмларни бошқаришга ва маълум 

даражадаги интерфаолликка эришилди. Ниқоб, оралиқ тасвирлар ва 

шаффофлик каби имкониятлар фойдаланувчиларнинг тасвирларининг янада 

сифатли бўлишига катта ҳисса қўшди. 

Flash 4. Бу дастурнинг энг муҳим афзаллиги сиқилган МР3-файлларни 

фильмларда эшиттириш имконияти эди. Шунингдек, бу версияда ActionScript 

тили сезиларли даражада такомиллаштирилган, бу эса интерфаол ўйинлар ва 

интерфейслар яратиш имкониятини очди. Шунингдек, таҳрирланадиган 

матнли майдонлар, фойдаланувчи интерфейсининг кўркамлиги ва 

маҳсулотларни чоп қилиш жараёнининг соддалаштирилганлигини ҳам айтиб 

ўтиш жоиз. 

Flash 5. Ушбу версиянинг энг муҳим жиҳати ActionScript тилининг 

такомиллаштирилганлиги эди. ЕСМА-262 стандартига мослаштирилган ушбу 

тил Macromedia компаниясига унинг Flash ва ActionScript элементлари энг 

номдор маҳсулотлар билан беллашишга тайёр эканлигини эълон қилишга асос 

бўлди. Шунингдек, фойдаланувчи интерфейси ҳам такомиллаштирилди, яъни 

қўшимча асбоблар ва Movie Explorer панели, Интернетдан ёрдам олиш, 

маҳсулотларни янгилаш ва фойдаланувчи тугмачалари комбинацияларини 

яратиш имкониятлари пайдо бўлди. 

FLASH МХ. Бу версиянинг номига анъаналардан четга чиқиб «МХ» 

қўшилди ва Интернет асосидаги рақамли медиатехнологиялар учун 

интеграллашган ечим тадбиқ қилинди. Эндиликда, Маcromediа нинг барча 
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маҳсулотларини (Flash, Dreamweaver, ColdFusion ва ҳ.к.) бутун қилиб 

интеграллаш имконияти яратилди. Шу билан бирга Flash Player юритувчиси 

(фильмларни юритиш учун) автоном ёки дастурга бириктирилган ҳолда ҳам 

ишлаб чиқарила бошланди. 

Macromedia Flash MX - асосан векторли графика асосида графика, матн, 

анимация ва веб-сайтлар учун иловалар яратишда қўлланилади. Улар 

импортланган видео, растрли графика ва овозни ҳам ўз ичига олади. Flash-

фильмлар интерфаол бўлади. Flash да ночизиқли фильмларни ҳам яратиш 

мумкин. Веб-дизайнерлар Flash дастуридан навигация элементлари, 

анимацияли логотиплар, синхрон овозли узун анимациялар ва сенсорли веб-

сайтларни яратишда ҳам фойдаланишади. Flash-роликларда ихчам векторли 

графика қўлланилиши сабабли улар тез юкланади ва экранга мослашади1. 

Мультипликация жанри бошқаларига ўхшамайди. Реклама, 

видеоўйинлар, кино, телевидение ва компьютерларнинг барчасида ахборотни 

ва ҳиссиётларни мультипликация воситасида беришади. 1996 йилда 

Масrоmеdiа компанияси томонидан бутун дунё ўргимчак тўри ишғол 

қилингандан сўнг анимациялар оммалашиб кетди2.  

Flash анимацияларни Интернетнинг деярли барча сайтларида, 

рекламаларда учратиш мумкин. Flash пайдо бўлгунча дизайнерлар, рассомлар 

ва HTML-дастурчилар узоқ вақт ҳаракатсиз тасвирлар билан ишлашган. Ушбу 

дастур уларга объектларни энг қулай усулда ҳаракатлантириш имконини 

берди. 

Flash-роликлар деярли барча веб-сайтларда учрайди. Macromedia нинг 

веб-сайтларидан миллионлар веб-сайтлар, браузерлар ва тизимли дастурлар 

ўзларига Flash Player ларни юклаб олишган. Flash Player тармоқда ёки автоном 

иловалар ҳолида компьютерда бўлиши ҳам мумкин. DVD-плеерлар фильмни 

DVD да кўрсатиш учун мўлжаллангани сингари, Flash Player ҳам Flash 

дастурида яратилган фильмларни намойиш қилиш учун хизмат қилади. 

Flash дастурининг FLA-файли дастлабки файл ҳисобланиб, анимация 

яратиш ва интерфаол контентни синаш учун барча маълумотларни ўзида 

сақлайди. SWF-файллар эса фақат фильмни кўрсатишга оид маълумотларни 

ўзида сақлайди. 

Flash да ишлаш. Бу дастурда бетакрор бадиий ишлар яратиш ва 

иллюстрацияларни импорт қилиш учун жуда кўп методлар мавжуд. Бунда 

асбоблар билан ясаш ёки мавжуд объектларнинг атрибутларини ўзгартириш 

орқали янги объектларни ҳосил қилиш мумкин. Flash дастурида бошқа 

иловалардан векторли, растрли графика, видеони ва овозли файлларни импорт 

қилиш ва уларни таҳрирлаш мумкин. 

Flash да анимация яратиш. Flash дастури объектларни анимациялаш, 

яъни саҳнада ҳаракатлантириш, шаклини, ўлчамларини, рангини, 

шаффофлигини ўзгартириш ва айлантириш мумкин. Бунда кадрдан кейин 

кадр ясаш ва ҳар бир кадрда алоҳида  тасвир ясаш мумкин. Шунингдек, 

анимация ичида анимация ҳосил қилиш ҳам мумкин. Бошланғич ва охирги 
                                                           
1 Vere E. and etc. Using Flash. San Francisco: - Macromedia, Inc. 2002, P. 17-18. 
2 Корсаро С. Мультипликация и Flash. – Пер. с англ. – СПб Символ-Плюс. 2008. С.16. 
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кадрлар орасида кадрларни дастурий тарзда ҳосил қилиш мумкин. Бунда 

анимациялар ва ўтиш эффектларини ҳосил қилишда объектга йўналтирилган 

ActionScript тилидан ҳам фойдаланиш мумкин. 

Flash дастури дастлаб Web-дизайнерлар учун ёзилган бўлса ҳам, 

кейинчалик моҳир 2D-аниматорлар томонидан тезда ўзлаштириб олинди. 2D-

анимациядаги фазовий чекланиш, уларнинг ижоди ва фантазиясини 

кучайтириб юборди. Flash дастурида анимация яратиш кенг имкониятлар 

бериш билан бирга ҳеч қанча пул талаб этмайди, бадиий маҳоратингиз ҳам 

юксак бўлиши шарт эмас, Интернетда чоп этишга кенг имкониятлар мавжуд. 

Флешерлар энг аввало флеш-анимацияларнинг сценарийсини 

режалаштириб олишади, кейин объектлар, кадрлар яратилади.  

Энг сўнгида анимациялар ва дастурнинг дизайни яратилади. Моҳир 

флешерларнинг тавсиясига кўра Flash дастурида анимация яратиш жараёни 

қуйидаги кетма-кетликда режалаштириб олинади3. 

 
сценарий 

ёзиш 

расм 

стилини 

танлаш 

кадрларга 

бўлиш 

лойиҳани 

тайёрлаш 

анимация ва 

фон яратиш 

таҳрирлаш 

ва ишлов 

бериш 

чоп этиш 

 
 

Flash да интерфаол фильмлар яратиш. Flash дастури интерфаол 

фильмлар яратиш имкониятига эга, бунда фойдаланувчи клавиатура ёки 

сичқончадан фойдаланиб фильмнинг турли қисмларига ўтиши, объектларни 

ҳаракатлантириши, шаклларга ахборотларни киритиши ва бошқа шу каби 

кўплаб операцияларни бажариши мумкин. Интерфаол фильмлар ActionScript 

сценарийлари орқали яратилади. 

Flash да иловалар яратиш. Flash дастурида кўп компонентли 

видеороликлар яратиш мумкин. Flash нинг ҳар бир компоненти ўз хусусий 

тўпламларига эга бўлади. ActionScript методлари ёрдамида уларнинг 

параметрларини ўрнатиш, ўзгартириш ва ижро вақтида қўшимча эффектлар 

ҳосил қилиш мумкин. Олдиндан белгиланган компонентларни ActionScript да 

қулай қўйиш имкониятлари орқали Веб учун кўп функцияли иловалар яратиш 

мумкин.  

Macromedia компанияси томонидан деярли 10 йиллик фаолияти даврида 

жуда кўплаб дастурий иловалар яратилди. Уларга Flash, Dreamweaver, Breeze, 

Flex, ColdFusion, Director, Authorware, FreeHand, Fireworks, Contribute, 

Robohelp, Captivate, Shockwave, JRun, Flash Communication Server, HomeSite, 

Flashpaper, Fontographer, Central, FlashCast, Web Publishing System, xRes, 

Extreme 3D, Final Cut каби иловаларни мисол қилиб кўрсатиш мумкин. 

Macromedia компанияси ва унинг технологияси 2005 йилда Adobe 

компанияси томонидан 3,4 миллиард долларга сотиб олинди. 

2008 йилда Adobe компанияси Open Screen Project (Очиқ экран) 

лойиҳасини бошлади. Бундан мақсад, шахсий компьютер, мобил қурилмалар 
                                                           
3 Киркпатрик Г., Пити К. Мультипликация во Flash. пер. с англ. К.В. Пожидаевой. -М.: НТ Пресс, 2006. С.16. 
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ва маиший электроника учун умумий дастурий интерфейсини яратиш бўлиб, 

бунда битта илованинг ўзи  санаб ўтилган қурилмаларда бир хилда ишлаши 

назарда тутилган. Шунингдек, SWF ва FLV/F4V файлларга қўйилган 

чекловлар олиб ташланади. Adobe Flash Player лар турли қурилмаларга 

мослашади. 

Flash-анимациялар векторли морфингга асосланган, бунда бир калит 

кадрдан иккинчисига "силлиқ" ўтиш мумкин ва бир нечта кадрлар орқали 

мураккаб мультипликациялар яратиш мумкин. Flash Player нинг ишлаш 

тезлиги HTML5 стандартини қўлловчи JavaScript виртуал машинасининг 

браузерларда ишлаш тезлигидан бир неча марта юқори4. 

Бугунги кунда техника ва технологиялар тобора ривожланиб  бормоқда. 

2017 йилнинг июлида Adobe компанияси Flash технологиясини компьютер 

процессорини зўриқтириши сабабли, янги замонавий қурилмалар учун қўллаш 

мақсадга мувофиқ эмаслигини таъкидлади ва бу технологияни 

ривожлантиришни 2020 йилнинг охирида тўхтатишини эълон қилди5. 

Лекин, бу дастур автоном тарзда шахсий компьютерларда ишлашда 

давом этади. Унда келгусида ўқув жараёнида қўлланиладиган дастурларни, 

ажойиб анимациялар ва мультимедиа иловаларни ҳеч қандай муаммоларсиз 

яратиш мумкин. Айниқса, Flash дастурининг EXE-маҳсулотлари Windows 

операцион тизимида автоном тарзда, ҳеч қандай плеерларсиз муваффақиятли 

ишлашда давом этади. 

 

1.2. Flash дастурининг график, анимацион, видео ва овоз имкониятлари 

Растрли ва векторли форматдаги графика. График тасвир векторли ва 

растрли форматларда сақланиши мумкин. Flash нинг ишлаш принципини 

тушуниш ва бу дастурнинг бошқа анимацион иловалардан афзалликларини 

тўла баҳолаш учун ушбу иккита форматнинг ўзаро фарқини билиб олиш керак. 

Векторли форматда график тасвирлар математик формулалар орқали 

ифодаланадиган эгри чизиқлар ёрдамида намоён бўлади. Бу усул тасвирнинг 

сифатини йўқотмасдан трансформацияланишини таъминлайди. Ҳар бир 

векторли объект иккита ранг характеристикаларига эга: контур чизиғи (stroke) 

ва ичи (fill). Векторли тасвирлашда контур чизиқ ва объектнинг ичи математик 

тарзда ҳисобланади. Бу тасвирни анимация қилишда жуда муҳим. 

Растрли график объектда тасвир пикселлардан (рангли нуқталардан) 

ташкил топган бўлади, уларнинг сони тасвирда бир неча миллион ҳам бўлиши 

мумкин. Инглизчада «pixel» сўзи «picture» (картинка, расм, сурат) ва «element» 

(элемент) сўзларидан олинган. Растрли тасвирни худди мозаикага ўхшатиш 

мумкин: ҳар бир майда таркибий элемент маълум миқдордаги хотирани 

эгаллайди ва расмнинг ташқи кўринишига ва бутун тасвирнинг ранг гаммасига 

таъсир кўрсатади. 

Векторли ва растрли тасвирларнинг муҳим фарқи уларни масштаблашда 

намоён бўлади. Векторли тасвир математик ҳисоблаш орқали ясалганлиги 

                                                           
4 http://www.themaninblue.com/writing/perspective/2010/03/22/  
5 https://blogs.adobe.com/conversations/2017/07/adobe-flash-update.html  

http://www.themaninblue.com/writing/perspective/2010/03/22/
https://blogs.adobe.com/conversations/2017/07/adobe-flash-update.html
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учун бундай тасвирни сифатини йўқотмасдан чўзиш, масштаблаш ва 

ўзгартириш мумкин. Юқоридаги операцияларни растрли тасвирда 

бажариладиган бўлса, тасвирнинг сифатининг пасайишига олиб келади. Чунки 

бунда бурчакларида пикселлар жойлашган тўр ўзгаради. Растрли тасвирнинг 

ўлчамини катталаштириш учун компьютер турли алгоритмлар ёрдамида 

қўшимча пикселларни ҳосил қилиш лозим. Растрли графикани 

катталаштирганда кутилмаган фрагментлар пайдо бўлиши ёки "зина" эффекти 

содир бўлиши мумкин. 

 

Flash MX интерфейси 

Илк саҳифа. 

Иш Flash дастурини очишдан бошланади. Бунда экранда илк саҳифа 

пайдо бўлади. 

 

 

 
 

1-расм. Flash MX дастурининг илк саҳифаси 

 

1-расмда Flash MX юкланганда пайдо бўладиган саҳифа кўрсатилган. 

Янги файл ёки мавжуд файлни очиш учун File ► New… ёки File ► Open… 

менюсидан ҳам фойдаланиш мумкин (мос равишда Ctrl+N ёки Ctrl+O 

тугмачалар кетма-кетлиги). 

Иш майдони ва саҳна. 

Саҳна – бу яратилаётган фильмнинг кадрларини ясаш учун 

мўлжалланган майдондир. Битта фильмда бир нечта саҳналар бўлиши мумкин, 

объектлар сони кўп бўлганда фильмни саҳналарга бўлиш ишни осон ва қулай 

қилади. 1-расмда кўрсатилганидек, оқ қисм – бу саҳна, кулранг қисм эса – иш 

майдонидир. Иш майдонининг пастки ва ўнг томонида экранни суриш 

Ойна боши 

Саҳна 

А
сб

о
б

-у
ск

у
н

ал
ар

 

п
ан

ел
и

 

Қатламлар панели Меню қатори Вақт чизиғи 

Панеллар 
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полосалари жойлашган.  

Иш майдони объектларни ясаш ва вақтинча жойлаштириш учун 

мўлжалланган. Фильм намойиш қилинганда фақат саҳнадаги объектлар 

кўринади. Саҳнадан иш майдонига чиқиб кетган объектлар эса кўринмасдан 

қолади. Иш майдонида заҳирадаги тасвирлар ва уларнинг контурларини 

сақлаш мақсадга мувофиқдир.  

Вақт чизиғи ёрдамида фильмнинг қанча вақт давом этиши, ҳар бир 

кадрнинг қанча вақт кўриниб туриши, шунингдек, турли объектларнинг 

кўриниш муддатлари белгилаб қўйилади.  

Қатламлар панели объектларни турли қатламларда жойлаштиришга 

имкон беради.  

Асбоблар палитраси. Асбоблар палитрасида контурларни чизиш, 

уларни танлаш, таҳрирлаш, ойнада ҳаракатлантириш ва бошқа кўплаб 

амалларни бажариш учун мўлжалланган барча инструментлар жойлашган. У 

бир нечта  бўлимлардан ташкил топган (2-расм).  

 

 
 

2-расм. Асбоблар палитраси 

 

Tools (Инструменты) бўлимида объектларни яратиш ва таҳрирлаш 
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асбоблари жойлашган. View бўлимидаги иккита асбоб кўриш масштабини 

ўзгартириш ва саҳнани ойнада ҳаракатлантириш учун ишлатилади. Colors 

бўлимида фаол рангларни бошқариш, контурларнинг ҳошиясининг рангини ва 

ичини тўлдириш учун рангларни танлаш асбоблари жойлашган. 

Юқоридаги Tools бўлимидан бирор асбоб танланса энг пастдаги  

Options бўлимидаги модификатор-кнопкалар Tools бўлимида танланган 

асбобга қараб ўзгариб туради. Улар ёрдамида ўша танланган асбобда 

ишлашнинг режимлари танланади. 

Координатали чизғичлар. Улар ҳужжат 

ойнасининг тепа ва чап қисмларида жойлашган 

бўлади (3-расм). Саҳнада сичқончанинг ўнг 

тугмачасини босиб Rules бандини танлаш 

орқали чизғичларни кўринадиган ёки 

кўринмайдиган қилиш мумкин.  

Йўналтирувчилар. Улар (яшил рангли 

чизиқлар) ёрдамида объектлар текисланади, 

тасвирнинг умумий ёки алоҳида чегаралари 

белгиланади. Улар фақат иш пайтида 

кўринади, печатга чиқмайди ва фильм 

намойишида кўринмайди. Йўналтирувчиларни 

экранга чиқариш учун координатали 

чизғичлар ёқилади ва чизғичга сичқонча билан 

босиб экран томонган ҳаракатланилади.  

Йўналтирувчиларни қўзалувчан ёки 

қўзғалмас қилиш мумкин (View ► Guides ► 

Lock Guides). Бунинг учун диалогли ойнада Lock Guides байроқчасини 

ўрнатиш керак (4-расм). Худди шу ойнада йўналтирувчиларнинг рангини ҳам 

танлаш мумкин.  

Тўр ёрдамида объектларни ясаш ва 

жойлаштиришда юқори аниқликка эришилади.  

Менюдаги View ► Grid ► Edit Grid 

командаси орқали тўрнинг қадами 

ўзгартирилади. Бунда ойнадаги (5-расм) 

горизонтал ва вертикал ўлчам қийматларини 

киритиш лозим.  

3-расм. Чизғичлар 

4-расм. Йўналтирувчиларни созлаш 

5-расм. Тўрни созлаш 
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Тўрга, йўналтирувчиларга ва объектларга тортилиш режими 

ёқилганда объектнинг нуқталари ва чизиқлари йўналтирувчининг ёки тўрнинг 

энг яқин тугунига “ёпишади”. Бу объектларни етарли даражада аниқ қилиб 

текислашга имкон беради. Тортилиш режими тўрни созлаш ойнасида Snap to 

Grid байроқчасини ўрнатиш орқали ёқилади. 

Hand асбоби ёрдамида ойнада иш 

майдонини ёки саҳнани суриш мумкин. Бу 

ишни экранни суриш полосалари ёки Hand 

асбоби ёрдамида ёки пробель тугмачасини 

босиб туриб ҳаракатлантириш ҳам мумкин. 

Қатламлар панели вақт чизиғининг 

чап томонида жойлашган (6-расм) бўлиб, 

унда қатламлар ясалади ва таҳрирланади. 

Қатламлар ўрнини ўзгартириб объектларнинг 

жойини ўзгартириш мумкин. 

 

График усуллар 

Тасвир рангини танлаш учун асбоблар палитрасида Colors 

бўлимида контур учун ва объект ичини тўлдириш учун ранглар 

белгиланган. Контур учун қалам шакли, тўлдириш учун эса бўёқли 

идиш шакли кўрсатилган (7-расм). 

Чизиқлар стили ва қалинлигини танлаш учун 8-расмдаги 

Pencil Tool асбоби ёрдамида контур чизиғи стилини ва 

қалинлигини танлаш мумкин. Чизиқ қалинлигини Hairline (соч 

толаси) стилидан бошқа барча стиллар учун ўзгартириш мумкин. 

 

 

 

Тўғри чизиқларни ясаш учун Line асбобида қўлланилади. Бунда 

сичқонча кўрсаткичи крест шаклини олади. Горизонтал, вертикал ёки 45о 

бурчак остида жойлашган чизиқларни ясаш учун клавиатуранинг Shift 

тугмачасини босиб туриш керак. 

Тўғри тўртбурчаклар ва эллипсларни ясаш учун Rectangle 

асбобидан фойдаланилади. Сичқонча кўрсаткичини саҳнанинг 

бирор жойига қўйиб ва кейин босиб ҳаракатлантирилса тўғри 

тўртбурчак ҳосил бўлади. Квадрат ясаш учун Shift тугмачасини 

босиб туриш керак. Тўғри тўртбурчакнинг бурчакларини юмалоқ-

лаш учун Options (хоссалар, параметрлар) (9-расм) бўлимида Set 

Corner Radius тугмачасини босиш керак ва диалогли ойнадан радиус 

қийматини киритиш керак. 

Oval асбоби ёрдамида айлана ва эллипсларни худди тўғри тўртбурчаклар 

каби ясаш мумкин. Бунда Shift тугмачаси босиб турилса, айлана ҳосил бўлади. 

Перо билан ясаш учун Pen асбоби танланади. Перо билан ясашда 

6-расм. Қатламлар панели 

7-расм. 

Ранглар 

панели 

8-расм. Контур чизиғи панели 

9-расм. 

Хоссалар 

панели 
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саҳнада перо кетма-кет босилиб ясалади. Перо ҳар босилганда битта таянч 

нуқтаси ҳосил бўлади ва бу нуқталар автоматик тарзда тўғри чизиқ билан 

туташади. Вертикал, горизонтал ва 45о бурчак остидаги чизиқларни ясаш учун 

клавиатуранинг Shift тугмачасини босиб турилади. 

Силлиқ эгри чизиқларни 

ясаш учун Pen (перо) асбоби 

қўллаш ҳам мумкин, бироқ бу 

иш қийинроқ амалга ошади. 

Бунинг учун саҳнанинг бирор 

жойига перо билан босилади ва 

сичқонча тугмачасини қўйиб 

юбормасдан, масалан, юқорига 

ҳаракатланилади (10-а расм). 

Бунда Shift тугмачасини босиб 

туриб аниқ 45 ёки 90о бурчак остидаги чизиқларни ҳам ҳосил қилса бўлади. 

Бунда таянч нуқталардан йўналтирувчи тўғри чизиқлар (эгрилик 

манипуляторлари), яъни эгри чизиққа ушбу нуқтадаги уринмалар ҳосил 

бўлганини кўриш мумкин. Уларнинг учида йўналтирувчи нуқталари бор.  

Иккинчи нуқтани бошқа жойга олиб бориб сичқончанинг тугмачасини 

босиб пастга қараб тортилса ёй ҳосил бўлади (10-б расм). Сичқончанинг 

тугмачасини қўйиб юбормасдан турли томонларга қараб ҳаракатлантирилса, 

чизиқнинг шакли манипуляторга қараб ўзгаришини кўриш мумкин. 

Қалам билан ишлаш худди қоғозга чизишдаги каби 

амалга оширилади. Бунинг учун Pencil асбоби танланади. 

Қалам билан чизиқнинг мураккаблигига қараб автоматик 

равишда таянч нуқталар пайдо бўлади. Қаламда ясашнинг 

уч хил усули мавжуд (11-расм): 

 Straighten (текислаш) – пайдо бўлган нотекислик-

ларни тўғрилайди, бунда тўғри чизиқ, синиқ чизиқ, ёй, 

айлана, овал, тўғри тўртбурчак, квадрат ва ҳоказо шакллар 

ҳосил бўлади. 

 Smooth (силлиқлаш) – ўткир бурчакларни силлиқлайди, контурнинг 

шакли деярли ўзгармайди. 

 Ink (ясаш) -  контур қандай ясалган бўлса 

шундайлигича қолади. 

Чўткада ясаш ва бўяш учун Brush (чўтка) 

асбоби қўлланилади. Унда қаламдаги каби ишлаш 

мумкин, бунда чизиқ ўрнига контурсиз полосалар 

пайдо бўлади. Иш жараёнида Options бўлимида 

чўткани созлаш панели чиқади (12-расм).  

Градиентли ранг қуйишни чизиқли Linear 

Gradient ва радиал Radial Gradient усулларида бажариш мумкин (13-а расм). 

Палитрадан стандарт рангларни Fill (ранг қуйиш) панелидан танлаш мумкин. 

Панелнинг пастки қисмида стандарт градиент ранглар келтирилган. 

10-расм. Перо билан эгри чизиқ ясаш 

 

а)  б)  в) 

11-расм. Қаламда 

ясаш 

 

Бўяш режими 

Чўтка ўлчами 

Чўтка шакли 

12-расм. Чўтка хоссалари 
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Улардан бирортаси танланган заҳоти экраннинг ўнг томонида 

градиентли ранг қуйишни созлаш панели пайдо бўлади (13-б расм). 

Градиентли ранг қуйишда ранглар сони 7 тадан ошмаслиги лозим. 

Янги рангни ҳосил қилиш амали Flash-

анимацияларни ишлашда зарур бўлади, бунда 

турли web-ранглар ҳосил қилиш мумкин. 

Фойдаланувчи ўзининг хусусий ранглар палитра-

сини яратиши ҳам мумкин. Бунинг учун 14-расмда 

кўрсатилган Mixer (аралаштиргич) панели қўлла-

нилади. Янги ранг ҳосил қилиш учун индикатор-

ларнинг пастки қисмида RGB кодини киритиш, 

ранглар шкаласининг керакли жойига босиш ёки 

ёрқинлик дастагини суриб янги ранг ҳосил қилиш 

мумкин. Рангни қисман шаффоф қилиш учун 

Alpha бандининг қийматини ўзгартириш лозим. 

 

Матн блоклари билан ишлаш 

 

Матнли блок статик, динамик ва киритиш 

майдони шаклида бўлиши мумкин. Статик матн 

ўзгармас бўлади. Динамик матнинг қиймати ўзгариб туриши мумкин. Матн 

киритиш учун киритиш майдони мавжуд (15-а расм). 

Матнни киритиш учун Text асбобидан фойдаланилади. Матнни икки хил 

ҳолатда киритиш мумкин. Биринчи ҳолатда, фақат битта қатор бўлади, 

кейинги қаторга ўтиш учун Enter тугмачаси босилади (15-б расм). Иккинчиси 

стандарт ҳолат бўлиб матн кенгайганда янги қатор очилиб боради (15-б расм). 

 а) б)  

13-расм. Ранг қуйиш панели 

14-расм. Рангларни созлаш 

панели 
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Матнли блок ўлчамларини ўзгартириш учун стандарт матнли 

блокнинг юқориги ўнг бурчагида квадратчаси бўлади (15-а расм). Уни 

сичқонча билан ушлаб ҳаракатлантириш орқали матнли блокнинг 

ўлчамларини ўзгартириш мумкин. “Резина” матнли блокда эса матн эни 

автоматик равишда ўзи чўзилиб боради, қаторлар эса Enter тугмачаси билан 

очиб борилади. 

Матн фрагментларини ажратиш Flash-анимациядан матнларни 

кўчириб олиш мумкин. Бунинг учун Text Options панелидаги Selectable 

(ажратиш) байроқчасини ўрнатиш лозим (16-расм). 

 
 

16-расм. Матн фрагментларини ажратиш 

 

Матнни векторли графикага айлантириш Flash-дастурининг ажойиб 

имкониятларидан биридир. Бу усул матнни градиентли тўлдиришнинг ягона 

усулидир. Бунинг учун Arrow (ўқ) асбоби билан менюда Modify ► Break Apart 

командаси бажарилади. Бунда ҳар бир символ алоҳида ҳошиясиз векторли 

графикага айланади. Бундай символларни ҳошиялаш ёки турли ранглар билан 

оддий ёки градиентли қилиб бўяш мумкин (17-расм). Бунда матнни Ctrl+G 

команда билан гуруҳлаш ҳам мумкин. Шундан кейин бутун матн блокини 

ҳаракатлантириш, масштаблаш, айлантириш мумкин. 

 
17-расм. Градиентли ранг тўлдирилган матн 

 

Одатда, контурга айлантирилган матнлар ниқоб сифатида ишлатилади. 

Бунинг учун бирор расмни (18-а расм) ниқоб қатламига қўйиб тагидан матн 

 

а) б) в) 

15-расм. Матнли блоклар 
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қўйилади. Матн Ctrl + B тугмачалар кетма-кетлиги билан бўлакланиб Mask 

(Ниқоб) режими орқали тасвирнинг устига қўйилади, бунда матнга орқадаги 

тасвирнинг фони ўтиб қолади (18-б расм). 

 

     
а)       б) 

18-расм. Ниқоб қатламидаги матн 

 

Ниқоб-матнни силжитиш, катталаштириш ёки кичиклаштириш мумкин. 

Flash-дастурида объектларни ажратиш, кўчириш, ўчириш, нусҳа олиш, 

гуруҳлаш ва трансформациялаш мумкин.  

Ажратиш учун Arrow (ўқ) асбобидан фойдаланилади. Баъзан объектни 

танлаб ажратишда Lasso асбобидан ҳам фойдаланилади.  

Объектларни кўчириш учун аввал улар 

ажратиб олинади, кейин сичқонча тугмачасини 

босиб ва қўйиб юбормасдан бошқа жойга 

кўчирилади. Агар бунда Shift, тугмачаси босиб 

турилса объектлар аниқ горизонтал, вертикал ёки 

45о бурчак остида кўчади.  

Объектларни стрелкалар билан кўчиришда 

ҳаракат тугмачасининг бир босилиши объектни 

бир пунктга, Shift тугмачаси босиб турилганда эса 8 та пунктга силжитади. 

Объектларнинг ҳаракат пайтидаги координаталарини ва ўлчамларини 

назорат қилиб бориш учун Info панелдан фойдаланилади (19-расм). 

Координаталар боши юқориги чап бурчакда жойлашган. Объектларни аниқ 

жойлаштириш учун уларнинг координаталарини киритиш ҳам мумкин. 

Объектларни ўчириш учун улар ажратилиб Del тугмачаси босилади ёки 

менюдан Edit ► Clear командаси бажарилади. 

Объектлардан нусҳа олиш учун Edit менюсидан Duplicate командаси 

бажарилади. Объект нусхаси сал пастроқ ва ўнгроқда пайдо бўлади. Кейин уни 

ҳоҳлаган жойга кўчириш мумкин.  Сичқонча ёрдамида нусҳа ҳосил қилиш 

учун объектни босиб,  Ctrl тугмачасини босиб турилган ҳолда зарур жойга 

кўчирилади. 

Гуруҳлаш амали одатда объектларни бириктириш учун қўлланилади. 

Бунинг учун юқорида келтирилганидек Ctrl+G тугмачалари ёки менюдаги 

Modify ► Group командаларидан фойдаланилади.  

19-расм.  Объектларнинг 

координаталари 
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Объектларни трансформациялаш деганда 

уларнинг ўлчамларини ўзгартириш, айлантириш, 

симметрик акслантириш, оғдириш тушунилади. 

Трансформациялаш учун Window ► Panels 

► Transform командаси берилади (20-расм). 

Панелга масштаблаш коэффициентини, айланти-

риш бурчагини, оғиш бурчагини киритиш лозим. 

Ўлчамларни аниқ белгилаш учун Info 

(21-расм) панелини очиб ишлаш керак бўлади. 

Объектларни айлантириш ва симметрик 

акслантириш учун Free Transform панели билан 

ишланади. Объектларни 90° га айлантириш учун 

менюнинг Modify ► Transform бандидан Rotate 

90° CW ёки Rotate 90° CCW командалари 

бажарилади.  

Объектларни қиялатиш учун Skew 

тугмачаси босилади ва панелга қиялик 

қийматлари киритилади. 

Объектларни устма-уст жойлаштириш 
учун Modify менюсидан Arrange бандида қуйидаги амаллар бажарилади: 

 Bring To Front – объектни энг олдинга (фронтга) чиқариш; 

 Send to Back – объектни энг орқа қаторга жойлаштириш; 

 Bring Forward – битта юқорига кўтариш; 

 Send Backward – битта пастга тушириш. 

Бу барча амаллар фақат битта қатлам доирасида бажарилади. Турли 

қатламларда жойлашган объектлар қатламларнинг жойлашиш ўрнига қараб 

қопланадилар. Объектларнинг ўрнини алмаштириш учун тегишли қатламлар 

ўрнини алмаштириш кифоя. 

Объектларни ҳосил қилиш жараёнида 

уларни битта чизиққа текислаш, бир-бирига 

нисбатан бир хал масофада жойлаштириш 

зарур бўлиб қолади. Бу амаллар Align пане-

лида бажарилади (22-расм). Ушбу панелни 

Ctrl+K тугмачалари ёки Window ► Panels ► 

Align командаси ёки асбоблар панели орқали 

чиқариш мумкин. Объектларни текислаш 

кўплаб тугмачалар мавжуд: 

 Align Left Edge – барча объектларнинг 

чап томонлари энг чапда жойлашган объектга текисланади; 

 Align Horizontal Center – барча объктларнинг вертикал ўқлари ўртага 

текисланади; 

 Align Rig-ht Edge – барча объектларнинг ўнг томонлари энг ўнгдаги 

объектга текисланади; 

 Align Top Edge – барча объектларнинг юқориги томонлари энг 

20-расм. Трансфор-

мациялаш панели 

22-расм. Текислаш панели 

21-расм. Info  панели 
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юқоридаги объектга текисланади; 

 Align Vertical Center – барча объктларнинг горизонтал ўқлари 

ўртадаги горизонтал чизиққа текисланади; 

 Align Bottom Edge – барча объектларнинг пастки томонлари энг 

пастдаги объектга текисланади. 

Иккинчи қатордаги Distribute (тақсимлаш) тугмачалари энг чеккадаги 

объектларни жойида қолдириб, қолган объектларни вертикал ёки горизонтал 

йўналишда орасини бир хил масофага келтиради: 

 Distribute Top Edge – юқоридаги объектга қараб вертикал тақсимлаш; 

 Distribute Vertical Center – марказдаги объектга қараб вертикал 

тақсимлаш; 

 Distribute Bottom Edge – пастдаги объектга қараб вертикал 

тақсимлаш; 

 Distribute Horizontal Center – марказга қараб горизонтал йўналишда 

тақсимлаш; 

 Distribute Right Edge – ўнгга қараб горизонтал йўналишда тақсимлаш. 

Space (оралиқ) бўлимидаги иккита тугмача объектлар орасида бир хил 

масофа бўлишини таъминлайди: 

 Space Evenly Vertically – вертикал бўйича тақсимлаш; 

 Space Evenly Horizontally - горизонтал бўйича тақсимлаш. 

Match Size (ўлчамига мослаш) бўлимидаги учта тугмача объектларни 

бир хил ўлчамга келтиради (эни, узунлиги ҳамда эни ва узунлиги бўйича). 

Намуна сифатида энг эни катта ёки бўйи катта объект олинади.  

Ойнанинг ўнг томонидаги То Stage (саҳнага) тугмачаси ёқилган бўлса 

объектларни текислаш ва тақсимлаш чеккадаги объектларга қараб эмас, балки 

саҳнага қараб амалга оширилади. 

 

Анимацион ҳаракатлантириш усуллари 

 

Анимацион ҳаракатлантиришнинг икки хил усули мавжуд. Биринчи 

усул – ҳар бир кадр навбатма-навбат ясаб чиқилади. Бу усул жуда қийин усул, 

жуда кўп вақтни талаб этади, файл ўлчамини ҳам ошириб юборади. Ундан 

фақат, кескин ўзгаришлар содир бўлиши керак бўлган жойлардагина 

фойдаланилади. Иккинчи усул – оралиқ анимация усули, унда фақат 

объектларнинг бошланғич ва охирги кадрлари ясалади, Flash-дастури оралиқ 

кадрларни ўзи ясайди.  

Оралиқ анимация икки хил – ҳаракат анимацияси ва шакл анимацияси 

(морфинг) кўринишида бўлиши мумкин. Ҳаракат анимациясида объект 

трансформацияланади, ҳаракатланади, рангини, шаффофлигини ўзгартиради. 

Бу хилдаги амаллар векторли графикадан бошқа барча объектлар учун амал 

қилади. 

Вақт чизиғи анимацияларни ишлашда асосий асбоб ҳисобланади 

(23-расм). У қатламлар панел билан бирлашиб кетган, чунки ҳар бир қатлам 

учун ҳар бир кадрнинг алоҳида объектлари бўлади. 
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23-расм. Вақт чизиғи 

 

Агар фильм узун бўлса, вақт дастагини топиш учун вақт чизиғининг 

пастки қисмида Center Frame (кадрни ўртага келтириш) тугмачаси босилади.  

Катта фильмларни яратишда кадр белгилари кўп ишлатилади. Бунинг 

учун зарур калит кадрга бориб кейин 24-расмда кўрсатилгандек Label (белги) 

майдонига белги номини (қисқа) киритиш лозим. 

 

 
 

24-расм. Кадр белгисини қўйиш 

 

Тажрибали дастурчилар дастур тузишда зарур жойларга изоҳ ёзиб 

кетадилар, бу уларга ишлашда қулайлик келтиради ва кейинчалик, вақт ўтиши 

билан дастурни тушуниб олишлари учун ҳам катта ёрдам беради. Белги ўрнига 

калит кадрлар учун изоҳ ёзиб қўйиш ҳам мумкин, бунда изоҳ олдида “//” 

белгиси қўйилади. Кадрда белгилар қизил байроқча, изоҳлар эса яшил 

чизиқлар шаклида кўринади (25-расм). 

 

 
 

25-расм. Кадрларга қўйилган белги ва изоҳлар 

 

Кадрларни ажратиш учун сичқонча тугмачасини босиб туриб керакли 

кадргача ҳаракатланиш зарур. Бўш кадрларни ажратиш жуда осон, бунинг 

учун Ctrl тугмачасини босиб туриб сичқончани ҳам босиб ҳаракатлантириш 

керак. 



32 
 

Кадрларни қўйиш учун (масалан, бир ёки бир нечта статик кадрларни 

фильм охирига қўйиш учун) вақт чизиғида бўш кадрни босиш ва F5 

тугмачасини босиш ёки Insert ► Frame командасини бериш керак. Бунда 

оралиқдаги кадрлар статик кадрлар билан тўлади. 

Кадр турини ўзгартириш учун (масалан, статик кадрни калит кадрга 

айлантириш керак бўлса) уни ажратиб туриб F6 тугмачаси босилади ёки  Insert 

► Keyframe командаси берилади. 

Баъзан оралиқ анимацияни кадрли анимацияга айлантириш эҳтиёжи 

пайдо бўлади. Бунинг учун ўша кадрларни ажратиб туриб менюдан Modify ► 

Frames ► Convert to Key Frames командасини бериш керак. 

Кадрларни ўчириш учун уларни ажратиб туриб Shift+F5 тугмачасидан 

ёки Insert ► Remove Frame командасидан фойдаланилади. Бунда фильм 

қисқаради. 

Кадрларни кўчириш учун уларни ажратиб бўлиб, кейин уларни 

сичқонча билан босиб бошқа жойга судраш керак. Бунда кўчган кадрларнинг 

ўрнида бўш статик кадрлар пайдо бўлади. Кўчирилган кадрлар эса жойлашган 

ўрнидаги кадрларни ўчириб юборади. 

Калит кадрдан нусха олиш ва уни бошқа жойга кўчириш учун Alt 

тугмачасини босиб ишлаш керак ёки Edit ► Copy Frames командасидан 

фойдаланиш лозим. Edit ► Cut Frames командаси эса ажратилган кадрларни 

қирқиб олади. Кадрлар нусхасини қўйиш учун эса қўйиладиган жойни босиб 

Edit ► Paste Frames командасини бериш керак.  

 

Кадрли ва ҳаракат анимациялари 

 

Кадрли анимация фақат калит кадрлардан ташкил топган бўлади. 

Кадрли анимацияда ҳар бир кадр битталаб ясаб чиқилади. Бунда ҳар бир янги 

кадрни очиш учун Insert Keyframe командаси ёки F6 тугмачасидан 

фойдаланилади. Ҳар бир янги очилган кадр ўзидан чап томонда турган калит 

кадрдаги объектларни ўзида такрорлайди. Янги кадр таҳрирланиб, зарур 

кўринишга келтирилиши зарур. 

Агар Onion Skin (калька) тугмачасини босадиган бўлсак 26-а расмда 

кўрсатилган паррак 26-б расмдаги кўринишга ўтади. 

 
а) б) 

 

26-расм. Кадрли анимация 
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Бу инструмент кадрли анимацияларни ясашда жуда катта ёрдам беради. 

Кадрли анимацияда ҳар бир кадрни ясаб чиқиш жуда кўп вақтни талаб этади. 

Шу сабабли кадрли анимация фақат кескин анимацион ўзгаришлар бўладиган 

жойлардагина ишлатилади.  

Ҳаракат анимацияси деганда символлар, гуруҳлар ва матнли 

блокларнинг ҳаракатлантириш тушунилади. Ҳаракат анимациясида фақатгина 

объектнинг ҳаракати эмас, балки ўлчамларининг ўзгариши, айланиши ва 

қиялиги ҳам ҳисобга олинади. 

 

 
 

27-расм. Ҳаракат турини танлаш 

 

Масалан, саҳнада 1-кадрда Rectangle асбоби ёрдамида квадрат ясайлик. 

31-кадрга Insert KeyFrame командасини бериш орқали янги калит кадр 

қўямиз. Энди 31-кадрдаги объектни ўзгартирамиз, бунинг учун уни соат 

стрелкаси бўйича 45 градусга айлантирамиз ва бошқа рангга бўяймиз. Энди 

Insert панелидаги Insert ► Create Motion Tween командасини берамиз. Бунда 

вақт чизиғида 1 кадрдан 31 кадрга қараб йўналган кўк рангли стрелка ҳосил 

бўлади. Пастда Tween  майдонида Shape бандини танлаймиз (27-расм).  

Энди Onion Skin (калька) тугмачаси ёки Edit Multiple Frames  командаси 

орқали 28-расмдаги тасвирни пайдо қиламиз. 

 
28-расм. Анимация натижаси 

 

Анимацияларни қисмларга бўлаклаш 

Турли тезланишли ва турли траекторияли ҳаракатларнинг 

анимациясини ясашда икки хил усул бор. Биринчи усул – олдинги калит 

кадрдан кейин ўнг томонда янги калит кадрларни очиб бориш. Бунда олдинги 

калит кадрнинг охирги статик кадри янги кадрга тушади. Шундан кейин янги 

калит кадр таҳрирланади. Бунинг учун энг биринчи кадр яратилаётганда 

Motion режимига ўтиб олинади, шундан кейин F6 тугмачаси билан 

очиладиган янги калит кадрлар ҳам ҳаракатли бўлиб қолади. 
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Иккинчи усул – ҳаракатларни бошидан охиригача режалаштириш 

усулидир. Бунда ҳаракатлар бир нечта участкаларга бўлаклаб олинади. 

Масалан, 29-расмда кўрсатилгандек 

доира чизиб оламиз, уни чоракларга ажратиб, 

турли рангларга бўяймиз (айланишини кўриш 

учун). Энди бошқа қатламда 30-расмдаги 

тепаликни ясаймиз. 

 
30-расм. Дастлабки кадр 

 

Энди Alt тугмачасини босиб кадрларни 50-кадргача сурамиз. Бунда 

статик кадрлар пайдо бўлади. Коптокчани ажратиб олиб F8 тугмачасини 

босиб уни Graphic типига ўтказамиз. Кейин F6 тугмачаси ёрдамида 

15-позицияга бориб янги кадр очамиз. Бу кадрни босиб, саҳнадаги коптокчани 

тепаликдан ўнг томонга пастроққа суриб қўямиз. 

Энди 31-кадрда Ctrl тугмачасини ҳам босган ҳолатда яна F6 

тугмачасини босамиз (31-расм). Янги кадрда коптокчани текисликнинг ўнг 

томонига, охирига суриб қўямиз. 

 
31-расм. Оралиқ калит кадр 

 

Кейин охирги 50-кадрни босамиз ва уни калит кадрга айлантирамиз. 

Коптокчани эса тепаликнинг энг пастки қисмига олиб келиб қўямиз. Бунда 

коптокчани соат стрелкаси бўйлаб 90 градусга буриб қўямиз. 

Шундан кейин биринчи кадрни босиб туриб Frame панелида Tweening 

очилувчи рўйхатидан Motion бандини танлаймиз. Бу ерда Eeasing деган 

майдонга -50 сонини киритамиз. Бунда копток аста-секинлик билан тезлашиб 

боради. Шу билан бирга Rotate очилувчи рўйхатидаги  CW (соат стрелкаси 

29-расм. Анимация 
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йўналишида) бандини босамиз ва Times (айланиш сони) майдончасига 

1 рақамини киритамиз. 

Иккинчи калит кадр учун ҳам ўша операциялар бажарилади, фақат бунда 

тезланишга +50 қийматини, айланишлар сонига эса 2 рақамини киритиб 

қўямиз. Учинчи калит кадрда тезланишга -100 қийматини, айланишлар сонини 

белгилаш учун Rotate (айланиш) рўйхатида Auto бандини танлаймиз 

(коптокча юқоридаги 90 градусга айланишини таъминлаш учун) (32-расм) 

 
32-расм. Якуний натижа 

 

Энди Control ► Rewind командасини берамиз ёки биринчи кадрни 

босамиз ва Enter тугмачасини босиб анимацияни кузатамиз. Ясалган анимация 

сақлаб қўйилади. 

Траектория бўйлаб ҳаракатланиш Flash MX дастурининг ажойиб 

хусусиятларидан биридир. Бунда объектлар боши ва охири белгиланган турли 

траекториялар бўйича ҳаракатланиши мумкин. Ҳаракатланиш траекторияси 

Insert ► Motion Guide командаси орқали йўналтирувчи қатламда ҳосил 

қилинади. Бу амални сичқончанинг ўнг тугмачасини босиб контексли 

менюдан Add Motion Guide командаси орқали ҳам бажариш мумкин. 

Ҳар бир ҳаракатланаётган объект учун ўзининг йўналтирувчи қатлами 

бўлади. Шу билан бирга бир нечта объектларни ҳам битта йўналтирувчи 

қатламга боғлаб қўйиш мумкин. 

Бунда траекториянинг бошланғич ва охирги нуқталари объектларнинг 

таянч нуқталарига мос келиши шарт. Бунинг учун магнит режимини ўрнатиб 

(View ► Snap to Objects командаси орқали), белгиланган нуқтага аниқ қўйиш 

мумкин. 

Объект траектория бўйлаб йўналган ҳолда ҳаракатланишини таъминлаш 

учун  Frame (кадр) панелида Orient to Path (траектория бўйлаб йўналиш) 

байроқчасини ўрнатиб қўйиш керак. 
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Flash-дастурининг маҳсулотларида ҳаракат 

траекторияси фильм намойишида кўринмайди. 

Энди 32-расмдаги файлни очамиз. Ва Insert 

► Motion Guide командаси орқали янги йўналти-

рувчи қатлам очамиз (33-расм). Бу қатламни аж-

ратиб биринчи кадрига коптокчанинг ҳаракатла-

ниш траекториясини чизамиз (34-расм). Бунда 

аввал тўғри чизиқ чизиб олиб кейин уларни 

Arrow (ўқ) тугмачаси ёрдамида эгрилаш зарур.  

 

 
34-расм. Ҳаракат траекторияси 

 

Йўналтирувчи қатлам сурилиб, силжиб кетмаслиги учун уни қулфлаб 

қўямиз ва Enter тугмачасини босиб анимацияни кўрамиз. 

Бир нечта объектлар битта траектория бўйича ҳаракатланиши учун ўша 

объектларни йўналтирувчи қатламнинг пастига сичқонча билан тортиб олиб 

келиб қўйиш керак. Йўналтирувчи қатлам остидаги қатламни Alt. тугмачасини 

босиб туриб сичқонча билан босилса у йўналтирувчи қатламга бўйсунадиган 

ёки бўйсунмайдиган қилиш ҳам мумкин. Бу ҳолатни 35-расмда кўриш мумкин. 

 

 
 

35-расм. Объектли қатламларни йўналтирувчи қатламга  

бўйсунадиган ва бўйсунмайдиган қилиш. 

 

 

33-расм. Йўналтирувчи 
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Шакл анимацияси 

 

Шакллар анимацияси гуруҳланмаган бирор контурни бошқа шаклга 

секин ўзгартиришга имкон беради. Бунда объектнинг ўрни, ўлчамлари, ранги 

ҳам ўзгаради. Градиент рангли объектлар анимация қилинганда градиент 

типини ўзгартирмаслик керак, чунки Flash-дастури чизиқли градиентни 

радиал градиентга ва аксинча қилиб айлантириб бера олмайди. 

Жуда кўп объектлар анимация қилинаётган бўлса, ҳар бир объектни 

алоҳида қатламда жойлаштириш зарур. Агар битта объектдан бир нечта 

объектлар ёки бир нечта объектдан битта объект ҳосил қилинаётган бўлса, 

уларни ҳам алоҳида қатламларда жойлаштириш лозим. 

Масалан, биринчи кадрда радиал градиент қуйишли доира, 15-кадрда 

(чап томонда) қизил доира, 30-кадрда кўк квадрат, 45-кадрда эса 90 градусга 

айланган яшил квадрат ясалса (36-расм), биридан бошқасига оҳиста 

ўзгаришини кузатиш мумкин. 

 
36-расм. Шакллар анимацияси 

 

 

Бунинг учун кадрларни ажратиб туриб Properties панелидаги Tween 

(оралиқ анимация) очилувчи рўйхатидан Shape (шакл) режими танланади ва 

Enter тугмачаси босилиб шакллар анимацияси ҳосил қилинади. 

Агар матн, ҳарфлар ёки уларнинг гуруҳлари билан анимация 

қилинадиган бўлса, у ҳолда матннинг тегишли қисми ажратилиб у Modify ► 

Break Apart командаси бажарилади. Растрли тасвирлар Modify ► Trace 

Bitmap командаси билан векторли кўринишга ўтказилиши лозим. 

 

Матн анимацияси 

Матнли блоклар учун матнли анимацияни амалга ошириш мумкин, яъни 

ҳаракатланиши, ўлчамини, шрифт катталигини ўзгартириши, айланиши ва 

оғиши мумкин. Бунда матнни ҳоҳлаган вақтда таҳрирлаш мумкин. 

Бироқ матннинг рангини секин ўзгартириш керак бўлса, матнли блокни 

олдин символга (вектролик графиккага) айлантириб олиш керак. Кейин унинг 

ранги охирги кадрда Effects панелидан ўзгартирилади. Бу панелдан матннинг 

шаффофлигини, оч-тўқлигини ҳам ўзгартириш мумкин. Матн ичидаги 

символни фақат таҳрирлаш режимидагина ўзгартириш мумкин (37-расм). 
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37-расм. Матн анимацияси 

 

Агар матндаги символларни алоҳида ҳаракатлантириш ёки 

деформациялаш керак бўлса, аввал уларни Modify ► Break Apart командаси 

билан алоҳида контурларга айлантириб олиш зарур. Агар ҳаракат анимацияси 

қилинадиган бўлса, барча ҳарфлар алоҳида объектли символларга 

айлантирилиши керак. 

 

Овоз билан ишлаш усуллари 

 

Flash дастури етарли даражада овоз билан ишлаш имкониятларига эга. 

Масалан, бирор ҳодисани қисқа товуш билан жонлантириш ёки анимациялар 

давомида такрорланувчан режимда бирор куйни қўйиш мумкин. Қўйилган 

овозни кучайтириш ёки пасайтириш, чап ва ўнг динамикларнинг овозларини 

алоҳида равишда созлаш мумкин. Катта ҳажмдаги овозли файлларнинг 

керакли жойини кесиб олиш мумкин. Булардан ташқари овозни кенг 

диапазонда сиқиш имкониятлари ҳам бор, бироқ бунда баъзи товушлар 

едирилиб йўқолиб кетади. 

Flash-дастурида овозлар икки хил бўлади: биринчиси – юкланиб 

бўлгандан кейин эшитила бошлайди, иккинчиси – дастлабки кадрлари 

юкланган заҳоти эшитила бошлайди. Иккинчи турдаги овозни вақт чизиғига 

боғлаб қўйиш мумкин. Биринчи турдаги овоз, агар у бирор кадрдан 

бошланишини инобатга олмасак, вақт чизиғига боғлиқ эмас. 

Агар овоз кнопкага боғлаб қўйилса, кнопка босилган заҳоти овоз 

эшитилади. 

Овозни импорт қилиш ҳам мумкин. Бунда Windows муҳитида кенг 

қўлланиладиган WAV ва МРЗ форматдаги овозли файллар юкланади. 

Овоз худди растрли графикага ўхшаб File ► Import командаси билан 

импорт қилинади ва кутубхонага тушади. Кутубхонадаги овозни файлнинг 

умумимий ўлчамини ўзгартирмаган ҳолда бир неча марта олиб ишлатиш 
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мумкин. Файлнинг ҳажмини кичрайтириш учун овозни сиқиш ҳам мумкин. 

Сиқиш параметрларини ҳар бир овоз учун алоҳида ёки бутун кутубхона учун 

ягона тартибда танлаш мумкин.  

Фильмни овоз билан бойитишда овозларни кадрларда жойлаштириш 

мумкин. Ҳар бир овоз бошқалари билан аралашиб кетмаслиги учун алоҳида 

қатламда жойлаштириш тавсия этилади. Бунда овозларни комбинациялаш 

жуда қулай, улар турли вақтда бошланиб, бир вақтда эшитилиши мумкин. 

Овознинг бошланиши учун вақт чизиғида калит кадр очилади. Овозни 

бошқа жойдан ушбу саҳнага бевосита келтириб ташлаш мумкин ёки 38-расмда 

кўрсатилган Sound панелини очиш керак. 

 

 
 

38-расм. Кадрга овозни қўйиш 

 

Овоз кадрга қўйилганда вақт чизиғида овознинг осциллограммаси пайдо 

бўлади, унга қараб овоз неча кадр, қанча вақт эшитилишини билиш мумкин.  

Овозни оддий усулда бирор тугмачага боғлаб қўйиш мумкин. Бунинг 

учун тугмачани очиб, унинг Down (босиш) калит кадрида саҳнага 

кутубхонадан овоз символи олиб қўйилади. 

 

 
 

39-расм. Овозни таҳрирлаш 
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Овоз каналларини таҳрирлаш учун таҳрирланадиган овоз панелдан 

танланиб кейин Edit тугмачаси босилади. Edit Envelope (қобиқни таҳрирлаш) 

диалогли ойнасида чап ва ўнг овоз каналларини алоҳида таҳрирлаш мумкин 

(39-расм). Том маънода, бу таҳрирлаш эмас, овоз кучини ўзгартиришдир. 

Ойнанинг юқориги қисмида чап канал учун, пастки қисмида эса ўнг 

канал учун овоз осциллограммаси жойлашган. Уларнинг ҳар иккаласида ҳам 

овозни ўзгартирувчи чизиқлар мавжуд. Уларда квадрат нуқталар бўлиб, улар 

ёрдамида чизиқларни эгрилаш мумкин.  

Эгри чизиқ формаси овознинг дастлабки амплитудасининг вақт бўйича 

пасайиш даражасини кўрсатади. У энг юқорида бўлса овоз умуман 

пасаймайди, энг пастга тушганда эса, овоз тўлиқ йўқолади. Эгри чизиқ оддий 

бошқарилади: горизонтал тўғри чизиқлар ва манипуляторлар ушлаб пастга ёки 

юқорига сурилади. Чизиқларда қўшимча нуқталар ҳосил қилиш учун, зарур 

жойига бир марта босилса кифоя. Манипуляторлар бир вақтнинг ўзида юқори 

ва пастки ойналарда, улар горизонтал йўналишда биргаликда ҳаракатланади, 

вертикал бўйича – алоҳида ҳаракатланади. Манипуляторни йўқотиш учун уни 

қўшни манипуляторнинг устига келтириш ёки ойнанинг четига суриш зарур. 

 

1.3. Анимациялар учун педагогик сценарийлар ишлаб чиқиш 

Мультимедиа маҳсулотларни қўллаш дарс жараёнининг қизиқарли ва 

таъсирчан кўринишга бўлишига олиб келади. Бироқ, амалда мультимедиа 

маҳсулотларини ўқув жараёнида қўллашда, мультимедиа материаллари 

мазмунида баъзи бир камчиликларни учратиш мумкин. Масалан: 

- Мультимедиа материаллари, айнан ўша фан мавзуси учун ишлаб 

чиқилмаган бўлиши мумкин. Агар у реклама материали сифатида ишлаб 

чиқилган бўлса, уни ўқув жараёнида қўллаш тўғри бўлмайди; 

- Баъзан мультимедиа маҳсулотлари дарс жараёнида ҳам, мустақил 

таълим учун ҳам қўлланади.  Бу нотўғри. Мультимедиа материали ҳар бир 

машғулот тури учун алоҳида ишлаб чиқилиши мақсадга мувофиқ. 

- Мультимедиа ишлаб чиқувчилар таълим жараёнида ўқитувчини тўлиқ 

"сиқиб чиқаришга" ҳаракат қилишади. Шуни эсдан чиқармаслик керакки, 

фақат мультимедиа маҳсулотидан фойдаланиб таълим натижаларига тўлиқ 

эришиб бўлмайди. Медиа маҳсулотидан фойдаланишда ўқитувчининг 

мунтазам кўрсатмалари ва айниқса, назорати жуда зарур. 

- Баъзи виртуал тренажёрлардан фойдаланилганда назарий маълумотлар 

тўлиқ тасдиқланади. Реал ҳаётда эса назариядан четлашишлар ва хатоликлар 

ҳам бўлиб туради. Бу инсоннинг борлиқни қабул қилишида жуда муҳим 

аҳамиятга эга. Виртуал тренажёрларда ҳам худди ҳаётдаги каби жузъий 

хатоликлар бўлиши уни табиийга яқинлаштиради. 

- Виртуал стендни қўллашдан олдин талабалар лаборатория жиҳози ва 

техник асбоб-ускуналар билан амалда тажриба ўтказиб кўрган бўлишлари 

шарт. Виртуал стендлар тасаввур пайдо қилиш учун эмас, балки мавжуд 

тажрибаларни, кўникмаларни такомиллаштириш учун зарур эканлигини 

унутмаслигимиз керак. 
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- Ҳар қандай мультимедиа маҳсулоти энг аввало ўқув мақсадларига 

қаратилган педагогик сценарий асосида ишлаб чиқилиши зарур. 

Мультимедиа материалларини ишлаб чиқишда энг аввало унинг 

қисмларини ва кадрларини аниқлаб олиш зарур. Мазмунни кучайтириш учун 

сeзгиларни (кўриш, эшитиш, тан билиш, ҳид билиш, таъм билиш), эмоционал 

ва ҳаракат ҳисларини ўйғотувчи образлар ҳам қўшилса мультимедиа 

маҳсулоти таъсирчан чиқади. Интерфаол мультимедиа маҳсулотлари билан 

ишлашда қуйидаги навигация элементлари ишлатилиши мумкин: 

- клавиатура комбинациялари; 

- сичқонча курсорининг ҳаракатлари ёки бармоқ ҳаракатларига TouchPad 

панелининг реакцияси; 

- сичқонча ғилдирагининг айланиши ёки TouchPad панели чекка 

ҳудудларининг реакцияси. 

Flash-анимация сцeнарийни визуаллаштириш жараёни бир қарашда осон 

бўлиб туюлади. Бироқ, дастлабки уринишларда, Flash-анимациянинг асосий 

элeмeнтларини билиш зарурлиги аён бўлади. Шу сабабли, технологик фанлар 

бўйича анимация яратишни ҳоҳловчилар, энг аввало Flash MX дастурининг 

асосий элeмeнтларини билиб олишлари мақсадга мувофиқ (40-расм). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

40-расм. Flash-анимациянинг асосий элементлари 

 

Flash-анимация 

элементлари 

Иш майдони Саҳна 

Қатламлар 

- Normal 

- Guide 

- Motion Guide 

- Mask 

Кадрлар 

- KeyFrame 

- BlankKeyFrame 

- Frame 

- Movie Clip 

- Button 

- Graphic 

Форматлар 

- FLA 

- SWF, EXE 

- BMP, GIF, 

JPG,  

- WAV, MP3 

- AVI, MPG 

- … 

- Allov (V) 

- Subselection (A) 

- Line (N) 

- Lasso (L) 

- Pen (P) 

- Text (T) 

- Oval (O) 

- Rectangle (R) 

- Pencil (Y) 

- Brush (B) 
- Free transform (Q) 

- Fill transform (F)  
- Ink bootle (I) 

- Paint bucket (K) 

- Evedropper (I) 

- Eraser (E) 

Вақт шкаласи 

Кутубхона 

Action Script 

Объектлар 

Анимация 

турлари 

- Мультипликация 

- Motion Tween 

- Shape Tween 

- Дастурли 

анимация 

Тезкор 

тугмачалар 

- F5, Shift+F5, 

F6, Shift+F6, 

F7 

- Ctrl+Shift+C, 

Ctrl+Shift+V 

- … 
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Ўрганувчи мазкур схeмада кeлтирилган барча элeмeнтларни билиб 

олгачгина, Flash MX дастурида самарали ишлаш малакаларига эга бўлади. 

Маъруза, амалий ва лаборатория машғулотлари бўйича виртуал 

стендларни ишлаб чиқишда ишни бажариш кeтма-кeтлигини белгилаб олиш 

зарур. Энг аввало, талабалар эришиши лозим бўлган таълим натижалари (TN) 

шакллантирилади. Улар асосида анимация кадрлари (К) яратилади (41-расм). 

Масалан, "Озиқ-овқат технологияси асослари" фани бўйича "Буғдой 

унининг клейковинасини аниқлаш" номли 2-лаборатория машғулотида 

қуйидаги мазмундаги ишни бажаришади. 
Ун намунасидан 0,1 г. аниқликда ўлчанган 25 г ун намунаси чинни косачага ёки 

ҳавончага солиниб, ҳарорати 18±2 ºС бўлган 14 мл сув билан хамир қорилади. Шиша 

таёқчага ёки қўлга ёпишган хамир бўлакчалари катта бўлакка қўшилади. Хамир тўлиқ 

муштлангунга қадар қорилади. 

Яхши қорилган хамир юмалоқ шар шаклига келтирилиб, у яна хам тўлиқ намланиши 

учун, фарфор косада усти ёпилиб, 18 ºС хароратда 20 минут тиндирилади.  

20 минутдан сўнг зувала сув остида, тагига зич элак тутиб ювилади. Крахмалнинг 

анча қисми ювилиб кетиб, аввал юмшоқ ва узилувчан бўлган клейковина таранглашади. 

Клейковина ювинди сув тиниқ холга келгунча ювилади. Зич элакга тушган бўлакчалар 

қайтариб қўшиб олинади.  

Тоза ювилганлигини текшириш учун клейковинадан сиқиб, ажратиб олинган икки 

томчи ювинди сувга бир томчи 1%-ли йод эритмаси томизиб кўрилади. Агар кўк ранг ҳосил 

бўлмаса, клейковина тўлиқ ювиб тозаланган бўлади.  

Ювилган клейковина кафтлар орасига олиб, суви сиқиб ташланади. Кафтлар сочиқ 

билан артилиб, клейковина бармоқлар билан ички қисми ўгирилиб, яна сиқиб ташланади. 

Ҳар бир сиқиб ташлангандан сўнг клейковина тарозида тортилади. Икки марта тарозида 

тортилган клейковина оғирлигининг фарқи 0,05 граммдан ошмаса, тажриба тугатилади. 

Клейковинанинг фоизда ифодаланган миқдори (К) қуйидаги формула бўйича ҳисобланади: 

 

К = 100 · Кт У⁄ ,% 
 

Бу ерда Кт – ундан тажрибада ювиб ажратиб олинган ва тарозида ўлчанган 

клейковина оғирлиги, г. 

У – тахлил учун олинган ун намунасининг оғирлиги, г. 

Ушбу мазмундаги тажриба ишини виртуал стендга айлантиришда олдин 

4 хил турдаги таълим натижалари бeлгилаб олинган. Яъни, мазкур ишни 

бажарган талаба: 

- виртуал стeнддаги асбоб-ускуналар билан ишлаш кўникмасига эга 

бўлади (TN 1); 

- клeйковина миқдорини аниқлаш кeтма-кeтлигини билиб олади (TN 2); 

- лаборатория ишига оид ҳисоб ишларини бажара олади (TN 3); 

- виртуал стeнд бўйича навигация амалларини бажаради (TN 4). 

Ушбу таълим натижаларига эришиш учун лаборатория машғулоти 

мазмунига мос тарзда 12 та кадр ишлаб чиқилган (қавс ичида эришиладиган 

таълим натижалари кўрсатилган): 

1-кадр. Титул варағи.  

2-кадр. 25 гр уннинг тарозида ўлчаб олиниши. (TN1, TN3) 

3-кадр. Унни косачага солиб устига 14 мл сув қуйилиши. (TN1, TN3) 

4-кадр. Хамир қориш, қорилган хамирнинг юмалоқланиши. (TN2) 
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41-расм. Таълим натижалари ва анимация кадрларининг ўзаро боғлиқлиги 

 

 

   

   

   

   
 

42-расм. Виртуал стенд кадрларидан намуналар 

 

5-кадр. Хамир 20 дақиқага тиндирилади, тиндириш жараёнида дон 

таркибидаги оқсиллар сувни ўзига ютиб бўкади. (TN2) 

6-кадр. Хамирнинг жилдираб турган сув оқимида ювилиши. (TN2) 

7-кадр. Клeйковинанинг тоза ювилганлигини йод эритмаси билан 

тeкшириш жараёни. (TN1, TN2, TN4) 

8-кадр. Клeйковинанинг тарозида ўлчаниши ва натижанинг жадвалга 

қайд қилиниши (TN1, TN2, TN3, TN4) 

TN1 TN2 TN3 TN4 

K4 K6 K8 K10 K5 K7 K9 K11 K2 K3 
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9-кадр. Клeйковинадан 4 гр ўлчаб олиб юмалоқлаш ва сувли идишга 15 

дақиқага солиб қўйиш жараёни. (TN2, TN4) 

10-кадр. Юмалоқланган хамирнинг ИДК-1 асбобига жойлаштирилиши 

ва пуансоннинг туширилиши, 30 сeкунд ўтгандан сўнг асбобни ўчириш ва 

кўрсатгичларни қайд қилиш. (TN3, TN4) 

11-кадр. Жадвалдан мос сифат кўрсаткичини бeлгилаш (TN3, TN4). 

12-кадр. Лаборатория иши натижаларини эълон қилиш. 

 

Лаборатория машғулоти мазмунига мос виртуал стeнд кадрлари матн, 

жадваллар, объeктлар, навигация элeмeнтлари ва скриптлар воситасида 

яратилган (42-расм). 

 

Навбатдаги мультимедиа ишланмасининг сценарийси визуал моделни 

намойиш қилиш учун келтирилган. Яъни, бунда дастур интерфейси ва 

пиктограммалар қандай бўлиши ҳақида маълумотлар келтирилган. 

Кимёвий технология фанлари бўйича мeдиаматн ишлаб чиқишда энг 

аввал ўқув матeриали мавзуси танлаб олиниши зарур. Унинг матни мазмунли 

бўлакларга бўлиб чиқилади. Ҳар бир мазмунли бўлак ичида бир нeча кадрлар 

ажратилади. Ҳар бир кадр ичида воқeаларни таъсирчан акс эттириш учун 

сeзгиларни ифодалаш, сюжeтни ривожлантириш, 2-юзада ифодалаш усуллари 

қўлланади. Улар қўшимча эффeктлар ёрдамида кучайтирилади (пайдо бўлиш, 

йўқолиш, зум, шовқин, мусиқа ва ҳ.к.). Ҳар бир воқeа, ҳодиса учун матннинг 

ўқилишига қараб, паузаларни ҳам ҳисобга олган ҳолда алоҳида вақт 

бeлгиланади.  

Қуйида, “Дарахтдаги ҳаётий жараёнлар” мавзусидаги матнни экранда 

сценарийлаштиришни кўриб чиқамиз. 
Дарахт учта асосий қисмдан таркиб топади. Илдизлари уни ерда тутиб туради, 

сув ва минeрал тузларни тупроқдан сўриб олишига ёрдам бeради. Танаси ва шохлари 

япроқларга шарбат элтади ва япроқларда ҳосил бўлган озуқа моддаларни пастга 

йўналтиради. 

Дарахтларнинг пўстлоғи билан қаттиқ ёғоч қисми ўртасида шарбат оқиб 

ўтадиган махсус қатлам бор. Бу қатламда ҳужайралар тeзроқ ўсади, шунинг ҳисобига 

тана йўгонлашиб боравeради. Бу қатлам ҳар йили дарахт танасига янги бир ҳалқа қўшади. 

Дарахтнинг кўндаланг кесиб бу ҳалқаларни санаш орқали ўсимликнинг ёшини билиб 

олиш мумкин. Япроқларга сув ва минeрал тузлар шу қатлам орқали ўтади. Пўстлоқ остида 

япроқлардан кeлаётган озуқа моддаларни бутун дарахтга тарқатадиган қатлам мавжуд. 

Дарахт ўсиши билан эски ҳалқалар дағаллашиб, пўстлоқ ва япроқлар билан алоқани 

йўқотади. Улардаги тирик ҳужайралар нобуд бўлади. 

Япроқлардаги яшил модда (хлорофилл) да қуёш нури таъсирида фотосинтез 

реакцияси содир бўлади. Бунда карбонат ангидрид гази ва илдизлардан кeлаётган сув ва 

унинг таркибидаги минeрал тузлар хлорофил ҳужайралари ёрдамида қанд ва крахмалга 

айланади. 

Мазкур техник матн асосида мультимедиали виртуал стенд яратиш учун 

экранни 9 та ҳудудга бўлиб оламиз (43-расм). 
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43-расм. Мультимедиали виртуал стенд интерфейсининг режаси 

 

 
 

44-расм. Мультимедиали виртуал стенд интерфейсининг амалда кўриниши. 

 

Майдонлар қуйидагича рақамланган:  

1 - Логотип; 

2 - Дастур мавзуси; 

3 - Чиқиш пиктограммаси; 

4 - Анимация пиктограммаси (виртуал стендни анимация режимига 

ўтказади, у ўчган ҳолда эса дастур тренажёр режимида ишлайди); 

5 - Овоз пиктограммаси (экран ортида нотиқ овози жараённи изоҳлаб 

бориши ёки юқорида келтирилган техник матнни ўқиб бориши мумкин); 

6 - Муаллиф ҳақида маълумот пиктограммаси; 

7 - Дарахтнинг умумий кўриниши (мазкур ҳудудда сичқончани 

ҳаракатлантириб керакли жойини танлаш мумкин); 

8 - Изоҳловчи матн (дарахтнинг муайян ҳудуди кўрсатилганда 
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экраннинг ушбу ҳудудида изоҳловчи матн ҳам пайдо бўлади); 

9 - Катталаштирилган анимацияли тасвирлар (7-ҳудуддаги 

сичқончанинг ҳаракатига мос равишда дарахтнинг ички кесимини ва ундаги 

ҳаётий жараёнларни (юқорига ва пастга оқиш, фотосинтез, озиқ моддаларнинг 

дарахт ичига қараб ҳаракатланиши ва ҳ.к.) кўрсатади). 

Экрандаги ҳудудлар сичқонча билан кўрсатишига қараб турли 

анимациялар содир бўлади (44-расм). 

 

Қуйида хавфли кимёвий тажрибалардан бири бўлган – "Натрийнинг 

сувда ёниши" анимациясининг сценарийси келтирилган. Анимацияни яратиш 

учун дастлаб, пeдагогик матн танлаб олинади ва ундаги лавҳалар 

визуаллаштирилади.  
Пeтри чашкасидаги сувга филтр қоғози қўйилиб, унинг устига Na мeтали қўйилади. 

Филтр қоғоз намланиб, сувга чўккандан сўнг Na мeтали сув билан рeакқияга киришиб 

Na2O2, H2O2 ва H2 ажралиб чиқа бошлайди. Na мeтали сувдан енгил бўлганлиги сабабли, сув 

юзасида қалқиб юради. Дастлаб Na мeтали тутайди, сўнг водород ёна бошлайди. Салдан 

кeйин тўпланиб қолган водород гази водород пeроксиди билан таъсирлашиб портлайди. 

Бу анамацияни яратиш учун қуйидаги мултимeдиа дастурлари ва 

манбаларидан ҳам фойдаланилган: 

- Macromedia Flash MX дастури – график объектларни ва анимацияларни 

ясашда, ҳамда зарур форматга конвeртациялашда фойдаланилган; 

- Paint дастури – Na бўлаги акс эттирилган растрли расмни қирқишда 

қўлланилган; 

- Мобил тeлeфон диктофони – овозни ёзиб олиш учун қўлланилган; 

- Movavi video convertor дастури Na нинг ёниш видeо лавҳасини, 

портлаш овозини қирқиб олиш ва овозни MP3 форматга ўтказиш учун 

қўлланилган; 

- Интeрнeтдан Пeтри чашкаси, Na бўлаги, Na нинг сувда ёниш 

видeолавҳалари юклаб олинган. 

Ишлаб чиқилган анимация 1 та Scene (1), 3 та Graphic (3), 1 та Bitmap (2), 

1 та Text (1), 2 та Button (5), 4 та Movie Clip (10), 2 та Sound (4), 2 та Action 

Script (10), 7 та Layer (1)  элeмeнтларидан иборат. Агар қавсда кeлтирилган 

мeъёрий баллар бўйича ҳисобланса, анимациянинг рeйтинги 98 балл бўлади. 

Қуйидаги жадвалда "Натрийнинг сувда ёниши" анимациясининг 

эффeктлари, уларни амалга оширувчи Flash-компонeнтлар ва таълим 

натижалари кeлтирилган. 

 

Эффeктлар  Флаш-компонeнтлар Таълим натижалари* 

Филтр қоғоздаги Na 

бўлагининг сувга 

қўйилиши 

Кадрнинг Tween:Motion 

хоссаси 

Т: Филтр қоғозни сувга ва 

устига Na бўлагини 

қўйиш кeрак 

Филтр қоғознинг сув 

шимиб рангининг 

ўзгариши 

"филтр_қогоз" 

объeктининг 

Color:Brigtness эффeкти 

Т: Филтр қоғоз гидрофоб 

модда, сув шимганда 

ранги тўқлашади 

Na бўлагининг сувда Кадрнинг Tween:Motion Т: Na мeтали сувдан 
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қалқиб туриши хоссаси енгил, унинг зичлиги 0,97 

г/см3 

Сувда пуфакчалар 

пайдо бўлиши 

"пуфакча" MovieClip-

объeкти 

Т: Рeакция натижасида 

сувда пуфакча пайдо 

бўлади 

Na бўлагининг 

кичрайиши 

Tween:Motion хоссаси Б: Na ёнганда кичраяди 

Na бўлагининг 

ҳаракати  

MotionGuide қатлами Б: Na ёнганда 

ҳаракатланади 

Na бўлагининг 

айланиши 

Кадрнинг Rotate:CW 

хоссаси 

Б: Na бўлаги сувда 

қалқиб, айланиб 

ҳаракатланади 

Na бўлагининг туташи  "тутун" MovieClip-

объeкти 

Б: Na олдин тутайди 

Na бўлагининг ёниши  "олов" MovieClip-

объeкти 

Б: Na тутайди, кeйин H2 

ёнади 

Na бўлагининг 

портлаши  

"портлаш" MovieClip-

объeкти 

Б: Ёниш босқичининг 

охирида Na портлайди 

Жараённи давом 

эттириш 

"OvalButtons - orange" 

объекти скрипти ("play") 

Қ: Тўхтаб турган жараён 

юритилади 
Изоҳ: * - Блум таксономияси катeгориялари: Б - билиш, Т-тушуниш, Қ - қўллаш. 
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45-расм. Na нинг сув билан реакциясига ишланган анимация лавҳалари. 

 

Бунда жадвалда кeлтирилган тайёр объектларни TimeLine чизиғига ва 

тeгишли Layer лардаги кадрларга қўйиб, объектлар устида Tween:Motion ва 

бошқа амалларини бажариб тeз дастурлаш кўникмаларига эга бўлиш мумкин. 

Flash дастурини мукаммал ўрганиш учун энг аввало унинг асосий 

элeмeнтларини яхши ўзлаштириб олиш кeрак. Агар Flash-компонeнтларнинг 

турлари ва сони маълум бўлса, Flash-анимациянинг иш ҳажмини, таннархини 

ва рeйтингини ҳам ҳисоблаш мумкин. 

 

Назорат саволлари: 

 

1. Flash MX дастурининг имкониятларини санаб беринг. 

2. Macromedia компанияси томонидан Flash дастурининг қандай версиялари 

ишлаб чиқилган? Flash MX тартиб бўйича нечанчи версия ҳисобланади? 

3. Flash MX дастурининг файллари қандай кенгайтмага эга? 

4. Flash-анимация деганда нимани тушунасиз? 

5. ActionScript тили қандай Flash MX га қандай имкониятларни тақдим этди? 

6. 2D-анимация нима ва у флешерлар учун қандай аҳамиятга эга? 

7. Flash Player нинг анимацияларни кўрсатиш тезлигига баҳо беринг? 

8. Adobe компанияси флеш-технологияларнинг қайси жиҳатларини замонавий 

қурилмаларга мос эмас, деб эътироф этган? 
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9. Растрли ва векторли графикаларнинг фарқи нимада? 

10. Flash MX интерфейси қандай қисмлардан иборат? 

11. Flash MX дастурида вақт чизиғи қандай вазифани бажаради? 

12. Flash MX дастурида қатламлар панелининг вақт чизиғига қандай 

боғлиқлиги бор? 

13. Flash MX дастурининг графика ясаш имкониятларини айтиб беринг. 

14. Flash MX дастурида градиентли бўяш қандай амалга оширилади? 

15. Flash MX дастурида Rectangle (тўғри тўртбурчак) асбобида айлана ясаш 

мумкинми? Жавобингизни асосланг. 

16. Flash MX дастурида ниқобдан қандай фойдаланилади? 

17. Flash MX дастурида кадрга белги ва изоҳ қандай қўйилади? 

18. Кадрли анимация ва ҳаракат анимациялари ўртасидаги фарқни айтиб 

беринг. 

19. Шакл анимацияси ва ҳаракат анимациялари ўртасидаги фарқни айтиб 

беринг. 

20. Калька режимидан қайси анимация турида ва қандай фойдаланилади? 

21. Flash MX дастурида матнни морфинг қилиш қандай амалга оширилади? 

22. Flash MX дастурида овозни таҳрирлашнинг қандай имкониятлари бор? 

23. Мультимедиа материалларида учрайдиган баъзи камчиликларни айтиб 

беринг. 

24. Мультимедиа материалларида қандай навигация элементлари 

ишлатилади? 

25. Macromedia Flash дастурининг асбоблар палитрасини таърифлаб беринг, 

уларда келтирилган асбоблар ёрдамида қандай  график ишларни бажариш 

мумкин? 

26. Macromedia Flash дастурида координатали чизғичлар, йўналтиргичлар ва 

тўр қандай мақсадларда  қўлланилади? 

27. Macromedia Flash дастурида кадр белгилари ва изоҳлар нима учун керак? 

28. Macromedia Flash дастурида кадрлар устида қандай операцияларни 

бажариш мумкин? 

 

Фойдаланилган адабиётлар: 

 

1. Vera E. Using Flash. San Francisco: - Macromedia, Inc. pp. 17-22, 48-58, 169-

187, 403-411. 

2. Корсаро С. Мультипликация и Flash. – Пер. с англ. – СПб Символ-Плюс. 

2008. С.16. 

3. Андерсен, Бент Б. Мультимедиа в образовании / Бент Б. Андерсен, Катя 

ван ден Бринк – М. : Дрофа, 2007. – 224 с.  

4. Киркпатрик Г., Пити К. Мультипликация во Flash. пер. с англ. К.В. 

Пожидаевой. -М.: НТ Пресс, 2006. С.16. 

5. http://www.themaninblue.com/writing/perspective/2010/03/22/ 

6. https://blogs.adobe.com/conversations/2017/07/adobe-flash-update.html 

 

 

http://www.themaninblue.com/writing/perspective/2010/03/22/
https://blogs.adobe.com/conversations/2017/07/adobe-flash-update.html
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2-маъруза: Flash дастурида интерфаол  

симуляторлар ишлаб чиқиш 

 

Режа: 

2.1. Flash дастурининг интерфаол элементлари. 

2.2. Интерфаол элементлар учун скрипт ёзиш. 

2.3. Симулятор учун педагогик сценарий ишлаб чиқиш.  

 

 

Таянч иборалар: Graphic symbol, Button, MovieClip, instance, symbol 

properties, CheckBox, ComboBox, ListBox, PushButton, RadioButton, ScrollBar, 

ScrollPane, ActionScript, onClipEvent, PhET, визуал модель, эмпирик модель. 

 

 

2.1. Flash дастурининг интерфаол элементлари. 

Flash дастурида симуляторлар ишлаб чиқишда символлардан кенг 

фойдаланилади. Символлар деганда график элементлар (Graphic symbol), 

тугмалар (Button) ва видеоклиплар (MovieClip) тушунилади. Символ ўз ичига 

ясалган ва импорт қилинган тасвирлар, овозлар ва видеоклипларни олиши 

мумкин. Символларни ясаш орқали ёки кутубхонадаги символни ўзгартириб 

ҳосил қилиш мумкин. 

Flash MX да символнинг нусҳаси (instance) кўп ишлатилади. Бунда ҳар 

бир объект қайта ясалмасдан, унинг нусҳаси қўлланилади, шу сабабли бу усул 

файлнинг ҳажмини кескин қисқаришига олиб келади. Нусҳа символдан ранги, 

ўлчамлари ва функциялари билан катта фарқ қилиши мумкин. Символ 

таҳрирланганда унинг нусҳалари ҳам мос равишда ўзгаради. Лекин, ҳар бир 

нусҳага киритилган хусусий параметрлар ўзгаришсиз қолади. Flash-

файллардаги символларни бошқа Flash-файлларга кўчириб ўтказиш мумкин. 

Бироқ, агар уларнинг номлари ва белгилари бир хил бўлса, келишмовчилик 

пайдо бўлади. 

Ҳар бир символ хусусий вақт шкаласи, қатламлари ва босқичларига эга 

бўлади. Flash MX дастурида қуйидаги символ турлари ишлатилади6: 

 -  статик расмлар учун кўп фрагментли анимацияларни ясашда график 

символлар (graphic symbol) қўлланилади.  

 - тугмалар (button) фильмда интерфаоллик ҳосил қилиш учун 

қўлланилади, уларга сичқонча билан таъсир кўрсатиш мумкин. Бунинг учун 

олдин тугманинг турли ҳолатлари учун графиклар белгилаб олинади, кейин 

эса тугма нусҳасига таъсир элементлари қўлланилади.  

 - кўп марта такрорланадиган анимацияларни ишлаш учун 

видеоклиплар (MovieClip) қўлланилади. Ҳар бир видеоклипнинг ўз вақт 

шкаласи, интерфаол тугмалари, овозлари ва ички видеоклиплари бўлиши 

                                                           
6 Vere E. and etc. Using Flash. San Francisco: - Macromedia, Inc. 2002, P. 149-150. 
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мумкин. Тугмаларни видеоклип ичига ёки видеоклипларни тугмалар ичига 

жойлаштириш ҳам мумкин. 

Символларни яратиш учун бирор объект белгилаб олинади ва контексли 

менюдан ёки F8 тугмасини босиш орқали Symbol Properties панели 

чиқарилади7.  

 

 
 

 

 

46-расм. Symbol Properties 

панелининг асосий ва 

кенгайтирилган кўриниши. 

 

 
 

Панелдан Movie Clip, Button, Graphic элементларидан бири танланади. 

 

Тугмалар 

 

Тугма тўртта кадрли интерактив видеоклип шаклида бўлади. Ҳар бир 

кадр ўзига хос вазифани бажаради. Дастлабки учта кадр тугманинг турли 

ҳолатларини кўрсатади, тўртинчи кадр эса тугманинг фаол ҳудудини 

белгилайди. Вақт шкаласи бу ерда аҳамиятга эга эмас, у кўрсаткичнинг 

ҳаракатига ва таъсирига қараб тегишли кадрдаги вазифасини бажаради. 

 

   
 

47-расм. Тугма кадрларининг вақт чизиғида кўриниши. 

 

Тугма ҳосил қилиш учун уни кутубхонадан танлаб, нусҳаси саҳнага 

қўйилади ва нусҳа учун параметрлар белгиланади. Ҳаракатлар нусҳага 

белгиланади, унинг кадрларига эмас. 

 

                                                           
7Vere E. and etc. Using Flash. San Francisco: - Macromedia, Inc. 2002, P. 151-153.  
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Тугманинг вақт шкаласидаги кадрлари турли функцияга эга (47-расм): 

• биринчи кадр - бу Up ҳолати, яъни эркин ҳолат, сичқонча кўрсаткичи 

тугмадан узоқда бўлгандаги ҳолат; 

• иккинчи кадр - бу Over ҳолати, яъни кўрсаткич тугма устида 

бўлгандаги ҳолат; 

• учинчи кадр - бу Down ҳолати, яъни тугмача босилгандаги ҳолат; 

• тўртинчи кадр - бу Hit ҳолати, яъни тугмачанинг ҳудуди ҳисобланади. 

 

Тугма компонентини сичқонча билан 2 марта босганда унинг ичига 

кирилади. Унинг менюсида ортга қайтиш тугмаси, саҳна номи ва тугма номи 

пайдо бўлади. Уларнинг дастлабки иккитасидан бирини босиш орқали ортга 

қайтиш мумкин. 

 

 

 
 

48-расм. Тугма ичидаги менюнинг кўриниши ва кадрлар жойлашуви8. 

 

                                                           
8 Шишканов Д.В. Технология создания учебных мультимедиа-продуктов в инструментальной среде 
Macromedia Flash MX. Краснояр.гос.ун-т. -Красноярск, 2004, 112 с. 
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Flash MX дастурида интерактивликни стандарт компонентлар асосида 

ташкил қилиш вақтни ҳам, ресурсларни ҳам тежайди. Компонентлар - бу 

мураккаб интерфаол видеоклиплар бўлиб, муайян параметрларга эга бўлади. 

Улар устида амал бажариш Flash нинг энг ажойиб хусусиятларидан биридир. 

Macromedia Flash MX дастури ўз таркибига 7 та компонентни олади: 

CheckBox, ComboBox, ListBox, PushButton, RadioButton, ScrollBar ва 

ScrollPane. Бу компонентлар веб-шакллар ёки иловалар интерфейсини 

яратишда алоҳида ёки биргаликда қўлланиши мумкин. 

Компонентларнинг ташқи кўринишини бир неча хил усуллар билан 

созлаш мумкин: 

• Ранг хусусиятлари ва матн форматини ўзгартириш; 

• Фойдаланувчи стилини 

яратиш; 

• Қобиғини ва унинг 

элементларини ўзгартириш. 

 

Компонентлар панели 

Window > Components 

командаси орқали экранга 

чиқарилади. 

 

49-расм. Компонентлар 

панелининг кўриниши. 

 

Шуни таъкидлаш керакки, компонентлар Action Script тили билан 

боғлиқ ҳолда қўлланилади. Ушбу тил ҳақида кейинги мавзуда маълумот 

берилган. 

 

CheckBox компоненти 

 

CheckBox компоненти боксдаги жавобни байроқ билан белгилаш учун 

қўлланилади.  

 

 
 

50-расм. CheckBox компонентининг кўриниши. 



54 
 

 

 
 

51-расм. CheckBox компонентининг хусусиятлар панели. 

 

Хусусиятлар инспектори панелида қуйидаги параметрларни белгилаш 

мумкин (51-расм): 

Change Handler - байроқнинг қиймати ўзгарганда чақириладиган 

функциянинг номини кўрсатади. Функция байроқ нусҳаси ёзилган вақт 

шкаласида аниқланиши шарт. Бу параметр шарт бўлмаган параметр 

ҳисобланади.  

Initial Value - байроқнинг танланган (true) ёки танланмаган (false) 

ҳолатини кўрсатади. 

Label - байроқнинг номи. 

LabelPlacement - номи байроқдан чап ёки ўнгда чиқишини кўрсатади. 

 

ComboBox компоненти 

ComboBox компоненти тушириб очиладиган рўйхатдан битта жавобни 

танлашга имкон беради. 

 

   
 

 
 

52-расм. ComboBox компоненти (статик ва таҳрирланадиган) ва хусусиятлар 

панелларининг кўриниши. 

 

ComboBox компонентида майдонлар статик ва таҳрирланадиган бўлиши 

мумкин. Статик майдонда ўзгармас рўйхат чиқарилади, у тушириб очилади ва 

уни айлантириб жавобни танлаш мумкин. Таҳрирланадиган рўйхатли майдон 

ҳам тушириб очилиши мумкин ва майдондаги матнни ўзгартириш мумкин.  

ComboBox компоненти қуйидаги клавиатура тугмалари билан ишлайди: 
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• "" ёки "" – бир қатор юқорига ёки пастга ўтилади. 

• PageUp ёки PageDown – бир бет юқорига ёки пастга ўтилади. Бет 

ўлчами Row Count параметри билан аниқланади. 

• Home ёки End – рўйхатнинг бошига ёки охирига олиб боради. 

Combo Box нинг ҳар бир нусҳаси қуйидаги параметрларни қабул қилади: 

Change Handler – элемент танланганда ёки матн ўзгартирилганда 

чақириладиган функциянинг номини кўрсатади. Рўйхатли нусҳа қайси вақт 

шкаласида бўлса, функция ҳам ўша ерда бўлиши керак. Бу параметр мажбурий 

эмас. 

Labels – рўйхатли майдонда чиқадиган элементларни кўрсатади. 

Data – матнга (labels) га боғланган қийматлар қатори. 

Editable – майдоннинг таҳрирланадиган ёки статик эканлигини 

билдиради. 

Row Count – айлантириш полосаси чиқиши учун камида нечта қатор 

бўлиши кераклигини белгилайди. Дастлабки ҳолатда 8 га тенг. 

 

ListBox компоненти 

 

ListBox компоненти очиқ рўйхат шаклида бўлиб бир ёки кўп бандларни 

танлаш имконини беради. 

 

  
 

53-расм. ListBox компонентининг бир ва кўп жавобли режимлари. 

 

 
 

54-расм. ListBox компонентининг хусусиятлар панели. 

 

ListBox компонентининг ҳар бир нусҳаси қуйидаги параметрларни 

қабул қилади: 

Change Handler – элемент танланганда чақириладиган функциянинг 

номини кўрсатади. Рўйхат нусҳаси қайси вақт шкаласида бўлса, функция ҳам 

ўша ерда бўлиши керак. Бу параметр мажбурий эмас. 

Labels – рўйхатли майдонда чиқадиган элементларни кўрсатади. 

Data – матнга (labels) га боғланган қийматлар қатори. 
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Select Multiple – танланадиган элементлар битта (false) ёки кўп (true) 

эканлигини билдиради. 

PushButton компоненти 

 

PushButton компоненти Flash-роликка оддий тугмаларни қўшишга 

имкон беради. 

 
 

 
 

55-расм. PushButton компонентининг кўриниши ва хусусиятлар панели. 

 

PushButton компонентининг ҳар бир нусҳаси қуйидаги параметрларни 

қабул қилади: 

Change Handler – элемент босилганда чақириладиган функциянинг 

номини кўрсатади. Тугма қайси вақт шкаласида бўлса, функция ҳам ўша ерда 

бўлиши керак. Бу параметр мажбурий эмас. 

Label – майдонда чиқадиган номни кўрсатади. 

 

RadioButton компоненти 

 

RadioButton компоненти радиотугмаларни Flash ҳужжатига қўшишга 

имкон беради. groupName параметри радиотугма нусҳаларини мантиқий 

битта қилиб гуруҳлайди ва гуруҳда фақат бир тугмани танлашга имкон беради. 

 

   
 

56-расм. RadioButton компонентининг кўриниши ва хусусиятлар панели. 

 

RadioButton компонентининг ҳар бир нусҳаси қуйидаги параметрларни 

қабул қилади: 

Change Handler – радиотугма танланганда чақириладиган функциянинг 

номини кўрсатади. Радиотугма қайси вақт шкаласида бўлса, функция ҳам ўша 

ерда бўлиши керак. Бу параметр мажбурий эмас. 

Label – радиотугманинг номи. 

Data – радиотугманинг қиймати. 
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LabelPlacement - номи радиотугмадан чап ёки ўнгда чиқишини 

кўрсатади. 

Group Name - радиотугмалар мантиқий гуруҳининг номи. 

Initial State - радиотугманинг танланган (true) ёки танланмаган (false) 

ҳолатини кўрсатади. Гуруҳда фақат битта радиотугмада true бўлиши мумкин. 

Агар бир нечта радиотугмада true қиймати бўлса, энг охирги радиотугманинг 

қиймати қабул қилинади. Бу параметр бошланғич ҳолида false қийматига эга. 

 

ScrollBar компоненти 

 

ScrollBar компоненти вертикал ва горизонтал айлантириш полосалари 

орқали майдонни экранда суриш вазифасини бажаради. Ушбу компонент 

статик майдонлар учун қўлланилмайди. 

 

   
 

   
 

57-расм. ScroolBar компонентининг кўринишлари ва хусусиятлар панели. 

 

ScroolBar компонентининг ҳар бир нусҳаси қуйидаги параметрларни 

қабул қилади: 

Horizontal – айлантириш полосаси горизонтал (true) ёки вертикал (false) 

эканлигини кўрсатади. 

Target TextField – матнли майдон номи. Айлантириш полосаси майдонга 

боғланганда бу ном автоматик тарзда пайдо бўлади. 

Агар матнли майдон ўлчамини ўзгартирадиган бўлсак, айлантириш 

полосасининг ўлчамини ўзгартиришнинг энг содда усули, уни майдондан 

четга олиб чиқиб, яна қайтадан ўша томондан олиб киришдир. 

 

ScrollPane компоненти 

 

ScrollPane компоненти флеш-роликларда вертикал ва горизонтал 

полосали ойналар қўшиш имконини беради. Бу компонент фақат 

видеоклипларни кўрсатади. 
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58-расм. ScrollPane компонентининг кўриниши ва хусусиятлар панели. 

 

ScrollPane компонентининг ичида видеоклипни акс эттириш учун 

видеоклипнинг ID ни scrollContent майдони ичида кўрсатиш зарур. Видеоклип 

кутубхонада сақланган бўлиши лозим. Бундан ташқари видеоклип "Export for 

ActionScript" параметрига ҳам эга бўлиши лозим. 

Drag Content – фойдаланувчи майдондаги объектни ушлаб торта 

олишини (true) ёки тортиш мумкин эмаслигини (false) билдиради. Дастлабки 

ҳолатда (false) қиймати белгиланган бўлади. 

Horizontal – горизонтал полоса кўрсатилиши (true) ёки 

кўрсатилмаслигини (false) билдиради. 

Vertical – вертикал полоса кўрсатилиши (true) ёки кўрсатилмаслигини 

(false) ва фақат зарур ҳолатда кўрсатилишини (auto) билдиради. Дастлабки 

ҳолатда (auto) ўрнатилган бўлади. 

ScrollContent – матнли қатор, видеоклипга мурожаат идентификатори 

кўрсатилади. 

LabelPlacement - номи радиотугмадан чап ёки ўнгда чиқишини 

кўрсатади. 

Group Name - радиотугмалар мантиқий гуруҳининг номи. 

Initial State - радиотугманинг танланган (true) ёки танланмаган (false) 

ҳолатини кўрсатади. Гуруҳда фақат битта радиотугмада true бўлиши мумкин. 

Агар бир нечта радиотугмада true қиймати бўлса, энг охирги радиотугманинг 

қиймати қабул қилинади. Бу параметр бошланғич ҳолида false қийматига эга. 

 

2.2. Интерфаол элементлар учун скрипт ёзиш. 

 

Flash дастури оддий анимацияларда кадрларни чизиқли тарзда намойиш 

қилади. Бироқ, интерфаол анимациялар ва симуляторларда клавиатура, 

сичқонча ёки бошқа қурилмалар томонидан ахборотни киритиш, объектларни 

кўчириш, бирор фрагментга ўтиш сабабли намойиш жараёни тармоқланган 

тарзда содир бўлади. Flash-анимациядаги интерфаоллик ActionScript тилида 

ёзилган сценарийларга боғлиқ бўлади.  
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Шуни ҳам таъкидлаш керакки, оддий интерфаол симуляторларни 

яратишда ActionScript тилини тўлиқ ўрганиш шарт эмас, чунки ҳодисалар ва 

бажариладиган амаллар мулоқот ойналари ва хоссалар панеллари ёрдамида 

содда ва тушунарли тарзда ташкил қилинган.  

 

ActionScript панели 

 

Flash MX нинг сценарий муҳарририга назоратчи дастур ўрнатилган 

бўлиб, у хатоларни аниқлайди ва тузатишга кўмаклашади. Бу муҳаррир оддий 

(Normal) ва жадал (Expert) режимларида ишлаши мумкин.  

Бошловчилар учун Normal режими қулай бўлганлиги учун фақат ушбу 

режим ҳақида маълумот берамиз. 

Normal режимида фойдаланувчига визуал вариантлар таклиф этилади ва 

қўл меҳнатидан деярли фойдаланилмайди. Амалиёт шуни кўрсатадики, бу 

режим мураккаб бўлмаган, лекин аниқ ишлайдиган интерфаол симуляторлар 

учун етарли ҳисобланади9. 

 

 
 

59-расм. ActionScript панелининг Normal режимининг кўриниши. 

 

ActionScript да клип, тугма ва кадр учун сценарий яратиш мумкин. 

Масалан, тугма объекти учун ўлчамлари, координатлари атрибут сифатида 

белгиланиши мумкин, тугмани босишга кўрсатиладиган реакция эса метод 

сифатида белгиланиши мумкин. 

 

Тугма учун скрипт ёзиш 

 

Тугма фойдаланувчи учун Flash-фильм билан мулоқот қилишнинг энг 

оддий ва қулай усули ҳисобланади. ActionScript тилида тугмалар учун 

қуйидаги ҳолатлар белгиланган: 
                                                           
9Vere E. and etc. Using Flash. San Francisco: - Macromedia, Inc. 2002, P. 187-244.   
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 Press – кўрсаткич тугма ҳудудида бўлганда сичқонча тугмасини босиш; 

 Release - тугма ҳудудида сичқонча тугмасини босиб қўйиш; 

 Release Outside - тугма ҳудудидан чиқиб сичқонча тугмасини қўйиб 

юбориш; 

 Key Press - клавиатуранинг бирор тугмасини босиш; 

 Roll Over - сичқонча кўрсаткичининг тугма ҳудудидан ўтиши; 

 Roll Out - сичқонча кўрсаткичининг тугма ҳудудидан чиқиши; 

 Drag Over - кўрсаткич тугма ҳудудида бўлганда сичқонча тугмасини 

босиб туриб, ҳудуддан чиқиб кетиш ва яна қайтиб кириш; 

 Drag Out - кўрсаткич тугма ҳудудида бўлганда сичқонча тугмасини 

босиб туриб, ҳудуддан чиқиб кетиш. 

 

     

 
 

61-расм. Action панелининг Button режимлари,  

тугмага ёзилган тўхтатиш скрипти ва тугмалар комплекси. 

 

Скриптлар10 Кўриниши Бажариладиган амаллар 

on (release) { 

 stop(); 

} 

 
Тугма ҳудудида сичқонча тугмасини 

босиб қўйилганда Timeline тўхтайди. 

on (release) { 

 play();  
Тугма ҳудудида сичқонча тугмасини 

босиб қўйилганда Timeline юриб кетади. 

                                                           
10 Шишканов Д.В. Технология создания учебных мультимедиа-продуктов в инструментальной среде 
Macromedia Flash MX. Краснояр.гос.ун-т. - Красноярск, 2004, C. 111-190 с 



61 
 

} 

on (press) { 

 getURL("C:/

/Windows/Help/ex

ample.html", 

"_blank");"); 

} 

 
Тугма ҳудудида сичқонча тугмасини 

босилган заҳоти 

C://Windows/Help/example.html файли 

броузернинг янги ойнасига чиқади. 

on (Release, 

Release Outside) { 

 getURL("C:/

/Windows/Help/ex

ample.html", 

"_self", "GET""); 

} 

 

 

Тугма ҳудудида сичқонча тугмасини 

босиб шу ҳудудда ёки ташқарида қўйиб 

юборилганда 

C://Windows/Help/example.html файли 

броузернинг жорий ойнасига чиқади. 

Маълумотларни жўнатиш учун GET 

методи қўлланилади. 

on (Release 

Outside) { 

 loadMovie("

example.swf", 

"C://Windows"); 

} 

 

Release Outside - тугма ҳудудидан 

чиқиб сичқонча тугмасини қўйиб 

юборилганда C://Windows/example.swf 

файли юкланади. 

on (Roll Over) { 

 stop(); 

} 

 
Сичқонча кўрсаткичи тугма ҳудудига 

кирганда Timeline тўхтайди. 

on (Roll Out) { 

 stop(); 

} 
 

Сичқонча кўрсаткичи тугма ҳудудидан 

чиққанда Timeline тўхтайди. 

on (Drag Over) { 

 goto(16); 

} 

 

Кўрсаткич тугма ҳудудида бўлганда 

сичқонча тугмасини босиб ҳудудга 

кирилса Timeline даги 16-кадрга 

ўтилади. 

on (Drag Out) { 

 goto(5); 

}  

Кўрсаткич тугма ҳудудида бўлганда 

сичқонча тугмасини босиб ҳудудга 

кирилса Timeline даги 5-кадрга ўтилади. 

 

Кадр учун скрипт ёзиш 

 

Симуляторнинг калит кадри билан муайян бир сценарийни боғлаш 

орқали ҳаракатлар автоматик тарзда белгиланади. 

Масалан, қуйидаги скрипт жараённи Timeline нинг 1-кадрига қайтаради. 



62 
 

 
 

62-расм. Кадрга ёзилган скрипт намунаси. 

 

Қуйида кадр учун скрипт намуналари келтирилган. 

 

gotoAndPlay(1); Timeline нинг 1-кадрига қайтиш ва 

давом этиш. 

loadMovie("C://Windows/example.swf"); Жорий кадрга келганда 

C://Windows/example.swf файлини 

экранга чиқариш 

fscommand("quit"); Жорий кадрга келганда дастурдан 

чиқиб кетилади. 

stop(); Жорий кадрга келганда Timeline 

да ҳаракат тўхтайди. 

 

Клип учун скрипт ёзиш 

 

Flash дастурида клип ҳам худди тугма каби кўп таъсирларга "жавоб 

қайтаради". Шу сабабли, Flash-симуляторларда клип объектига кўплаб 

сценарийлар ёзилади. 

Масалан, клипни интерфаол қилиш учун Action панелидаги 

MovieClipControl командасининг қуйидаги параметрларидан фойдаланиш 

мумкин (63-расм). 
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onClipEvent (mouseUp) { 

    stop(); 

} 

 

63-расм. Action панелидаги MovieClipControl командалари  

ва onClipEvent командасига сичқонча тугмаси қўйиб юборганда тўхтатиш 

учун ёзилган скрипт. 

 

Клип устида амаллар бажариш учун қуйидаги параметрлардан 

фойдаланиш мумкин: 

 load — клип юкланганда бажариладиган ҳаракат; 

 unload — клипдан чиқиб кетилганда  бажариладиган ҳаракат; 

 enterFrame - ҳар бир кейинги кадрга ўтилганда бажариладиган ҳаракат; 

 mouseMove — сичқонча кўрсаткичи ҳаракатланганда бажариладиган 

ҳаракат; 

 mouseDown — сичқончанинг чап тугмаси босилганда бажариладиган 

ҳаракат; 

 mouseUp — сичқончанинг чап тугмаси қўйиб юборилганда 

бажариладиган ҳаракат; 

 keyDown — клавиатурадаги бирор тугмача босилганда бажариладиган 

ҳаракат; 

 keyUp — клавиатурадаги бирор тугмача босиб қўйиб юборилганда 

бажариладиган ҳаракат; 
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 data — сервердан маълумотлар юклаб бўлингандан кейин 

бажариладиган ҳаракат. 

 

 
 

64-расм. onClipEvent командасининг параметрлари 

 

Баъзи симуляторларда сичқонча кўрсаткичини бирор объект билан 

алмаштириш зарур бўлади. Масалан, кимёвий симулятордаги пипеткани 

сичқонча курсори билан алмаштириш орқали ва зарур ҳудудларга пипетка 

билан бориб керакли миқдорда томчиларни томизиш мумкин. 

 

 
 

onClipEvent (mouseMove) { 

 setProperty(this, _x, _root._xmouse); 

 setProperty(this, _y, _root._ymouse); 

} 

 

65-расм. onClipEvent командасининг mouseMove параметри орқали сичқонча 

курсорини "pipetka" MovieClip объекти билан алмаштириш скрипти. 

 

2.3. Симулятор учун педагогик сценарий ишлаб чиқиш.  

 

Ҳар қандай симуляторнинг асосини педагогик сценарий ташкил этади. 

Энг аввал қандай натижаларга эришиш лозимлигини аниқлаб олиш зарур. 
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Кейин ҳар бир таълим натижасига эришиш учун зарур фрагментларни излаш 

лозим бўлади.  

Симулятор иккита моделга асосланади - визуал ва эмпирик. Визуал 

моделда асосан унинг интерфейси, эргономияси ва дизайни шакллантирилса, 

эмпирик моделда ўзгарувчиларининг ўзаро боғлиқлиги, математик ифодалар 

ва маълумотлар базаси шакллантирилади. 

Фрагментлар ва компонентлар асосида симулятор контентлари 

тайёрланиб, йиғилиб, кейин улар Flash дастурида визуал ва эмпирик моделлар 

асосида симулятор шаклига келтирилади. 

Симуляторлар одатда янги олинган назарий билимларни мустаҳкамлаш, 

орттирилган тажрибаларни машқ қилиб янада такомиллаштириш учун 

қўлланилади. Симуляторлар воситасида Б.Блум педагогик таксономиясининг 

билиш, тушуниш, қўллаш, анализ, синтез ва баҳолаш даражаларининг 

барчасига эришиш мумкин. Симуляторларда машқ қилиб малакасини оширган 

мутахассис реал вазиятда муаммоларни ҳал қилишга тайёр бўлади. 

Педагогик амалиётда симуляторларнинг самарасини баҳолаш мақсадида 

уларнинг педагогик сценарийсини таҳлил қилиш тажрибаси кўп учрайди. 

Ушбу ҳолатда биз ҳам бу методни қўллаймиз. Яъни, яратилган симуляторнинг 

педагогик сценарийсини таҳлил қиламиз. 

Нобель мукофотининг лауреати, физик К. Виман томонидан «Physics 

Education Technology» (PhET) сайти яратилган (https://phet.colorado.edu/). 

Сайтдан  симуляторларни бепул кучириб олиш мумкин. PhET сайтида ҳар хил 

мавзуларга оид моделлар мавжуд бўлиб, улар Java (ва HTML5 форматларида) 

дастурида яратилган. PhET сайтида тақдим этилаётган моделлардан очиқ 

манба сифатида, исталганча фойдаланиш мумкин. 

PhET да бир нечта 360 миллиондан ортиқ симуляторлар мавжуд бўлиб 

улар Физика, Математика, Кимё, Биология фанларига оид моделлаштириш 

дастурларидан иборатдир. Бу дастурлар мукаммал ўқув адабиётлари асосида 

ишлаб чиқилганлиги сабабли муҳим педагогик қурол ҳисобланади.  

Компьютер моделларини ўқув жараёнларида қуйидаги ҳолатларда 

қўллаш тавсия этилади: 

1. Тажрибани ўтказиш мумкин бўлмаган ёки тажриба кузатиб бўлмас 

даражада бўлганда қўллаш; 

2. Ўқув объектини аниқлаш ёки ечилаётган масалани иллюстрациялаш; 

3. Лаборатория машғулотларини бажариш жараёнида ушбу 

симуляторлар ёрдамида ҳодисаларни характерловчи катталикларнинг ҳам 

сифатий, ҳам миқдорий боғланишларини таҳлил қилиш; 

4. Симулятордан турли мураккабликдаги топшириқларни бажариш, 

илмий изланишлар олиб бориш, мустақил ўрганиш учун фойдаланиш мумкин. 

Ушбу сайтдаги "Водород кўрсаткичлари шкаласи асослари" номли 

симуляторда (https://phet.colorado.edu/en/simulation/ph-scale-basics) ҳаётимиз-

да кўп ишлатиладиган турли моддаларнинг pH кўрсаткичлари берилган, 

уларни сув билан аралаштириш орқали pH кўрсаткичининг ўзгаришини 

тажриба қилиб кузатиш мумкин. 

 

https://phet.colorado.edu/
https://phet.colorado.edu/en/simulation/ph-scale-basics
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66-расм. Турли моддаларнинг концентрацияларидаги pH кўрсаткичини 

аниқлаш бўйича PhET сайтидан олинган симуляторнинг визуал модели. 

 

Мазкур симулятор 13 хил компонентни ўз ичига олган: 

 

Симулятор 

компоненти 

Flash- 

компонент 
Функцияси 

1. pH-метр. Graphic pH даражалари қайд қилинган бўлиб 

иккита – кислотали ва ишқорий муҳитга 

бўлинган. 

2. pH-метр 

кўрсаткичи. 

MovieClip Ичига динамик матн жойланган клип 

бўлиб, якуний натижани кўрсатади, pH 

ўзгариши билан объектнинг вертикал 

координаталари ўзгаради. 

3. pH-метрнинг 

индикатори. 

Button Drag-and-drop методи билан 

кўчириладиган тугма. Идишда суюқлик 

бўлган ҳолда идиш ҳудудига ярмидан кўп 

қисми кирганда қийматни кўрсатишга 

рухсат беради, акс ҳолда "-" ни 

кўрсатилади. 

4. Ҳаётда 

учрайдиган турли 

моддалар ва 

уларнинг pH-

кўрсаткичи 

рўйхати. 

MovieClip Drain Cleaner (қувур тозалагич) -13; Hand 

Soap (atir sovun) - 10; Blood (қон) - 7,4; 

Spit (тупук) - 7,4; Milk (сут) - 6,5; Chicken 

Soup (товуқ шўрва) - 5,8; Coffee (кофе) - 5; 

Orange Juice (апельсин шарбати) - 3,5; 

Soda Pop (содали сув) - 2,5; Vomit (ўт 

суюқлиги) - 2; Battery Acid (аккумулятор 

кислотаси) - 1. 
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5. Турли pH 

қийматига эга 

моддаларни 

танлаш тугмаси. 

Button Босилганда суюқликлар рўйхатини 

кўрсатади. Дастлабки ҳолатда Chicken 

Soup (pH - 5,8) қийматини кўрсатади. 

6. Пипетка. Button Тугмачаси босилганда маълум миқдорда 

суюқлик оқиб тушади. 

7. Сув қувури. Graphic Дистилланган сув оқиб тушади. 

8. Сув қувури 

жўмраги. 

Button Тугмачаси босилганда маълум миқдорда 

суюқлик оқиб тушади. 

9. Дренаж қувури. Graphic Суюқлик аралашмаси чиқиб кетади. 

10. Дренаж 

қувури жўмраги. 

Button Тугмачаси босилганда маълум миқдорда 

суюқлик аралашмаси чиқиб кетади. 

11. Тажриба 

идиши. 

Grapic Суюқликларни сув билан аралаштириб 

маълум концентрацияга келтиради. 

12. Тажрибани 

қайтадан бошлаш 

тугмаси. 

Button Тугмача босилганда дастур дастлабки 

ҳолатга қайтади. 

13. Суюқлик MovieClip Суюқликларнинг ва уларнинг 

дистилланган сув билан 

аралашмаларининг ҳажмини ва 

концентрациясига кўра рангини 

кўрсатади. 

 

Энди, симуляторнинг эмпирик моделини таҳлил қиламиз. 

Симуляторнинг чиқиш кўрсаткичи - pH кўрсаткичидир (2-объект). 

Унинг қиймати суюқлик концентрациясига (𝐶𝑙, 13-объект) ва индикаторнинг 

суюқликка ботишига (𝐼𝑝𝐻, 3-объект) боғлиқ. Шунингдек, унинг 

координаталари (𝐶𝑝𝐻) ҳам бевосита pH кўрсаткичига қараб ўзгаради: 

𝑝𝐻 = 𝑓(𝐶𝑙 , 𝐼𝑝𝐻) 

𝐶𝑝𝐻 = 𝑓(𝑝𝐻) 

 

Суюқлик концентрациясининг қиймати (𝐶𝑙)  суюқ модда турига (𝑇𝑙), 
қанча миқдорда суюқ модда (𝐿𝑖, 6-объект) ва дистилланган сув (𝑊, 7-объект) 

қуйилганига, шунингдек, қанча миқдорда дренаж суюқлиги (𝐶𝑑, 9-объект) 

оқиб чиқиб кетганлигига боғлиқ. Шунингдек, идишдаги суюқликнинг ранг 

палитраси (𝐶𝑝) ҳам ушбу қийматларга боғлиқ: 

𝐶𝑙 = 𝑓1(𝑇𝑙 , 𝐿𝑖 ,𝑊, 𝐶𝑑) 
𝐶𝑝 = 𝑓2(𝑇𝑙 , 𝐿𝑖 ,𝑊, 𝐶𝑑) 

 

Идишдаги суюқликнинг ҳажми (𝐶𝑉) қанча миқдорда суюқ модда (𝐿𝑖, 
6-объект) ва дистилланган сув (𝑊, 7-объект) қуйилганига, шунингдек, қанча 

миқдорда дренаж суюқлиги (𝐶𝑑, 9-объект) чиқиб кетганлигига боғлиқ: 

𝐶𝑉 = 𝑓(𝐿𝑖 ,𝑊, 𝐶𝑑) 
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Индикаторнинг суюқликка ботиши унинг координаталари (𝐼𝑋, 𝐼𝑌) ва 

идишдаги суюқлик ҳажми, яъни тугма ҳудуди (𝐿𝑋1, 𝐿𝑌1, 𝐿𝑋2, 𝐿𝑌2) билан боғлиқ: 

 

𝐼𝑝𝐻 = 𝑓(𝐼𝑋, 𝐼𝑌, 𝐿𝑋1, 𝐿𝑌1, 𝐿𝑋2, 𝐿𝑌2) 

 

Суюқ модданинг тури (𝑇𝑙, 4-объект) рўйхатдан олинади: 

Суюқ модданинг қанча оқиб тушиши (𝐿𝑖, 6-объект) унинг 6-объект 

тугмасининг қанча вақт (𝑡6) босилиб турганлигига боғлиқ: 

𝐿𝑖 = 𝑓(𝑡6) 
 

Дистилланган сувнинг қанча қуйилганлиги (𝑊, 7-объект) 8-объект 

тугмасининг қанча вақт (𝑡8) босилиб турганлигига боғлиқ: 

𝑊 = 𝑓(𝑡8) 
 

Дренаж суюқлигининг қанча миқдорда чиқиб кетганлиги (𝐶𝑑, 9-объект) 

10-объект тугмасининг қанча вақт (𝑡10) босилиб турганлигига боғлиқ: 

𝐶𝑑 = 𝑓(𝑡10) 
 

Қуйидаги схемада (67-расм) юқорида таҳлил қилинган эмпирик 

боғлиқликларнинг иерархик схемаси келтирилган. 

 

 
 

67-расм. Симулятор ўзгарувчиларининг боғлиқлик иерархияси. 

 

Ушбу схема асосида математик ифодалар тузилади ва ActionScript 

тилида скрипт ёзилади. 

Файлни EXE форматида чоп қилиш мақсадга мувофиқ, чунки 

FlashPlayer нинг юқори версиялари Flash MX да тузилган дастурни 

ўқимаслиги мумкин. 

 



69 
 

Назорат саволлари: 

1. Flash MX дастурида интерфаолликни таъминловчи қандай 

компонентлар мавжуд? 

2. Тугмалар (Button) нечта кадрдан иборат бўлади? 

3. Тугмаларнинг (Button) кадрлари қандай вазифаларни бажаради? 

4. Тугма ичига клип жойлаштириш мумкинми? Клип ичига тугманичи? 

5. Flash MX нинг CheckBox компонентини таърифлаб беринг. 

6. Flash MX нинг ComboBox компонентини таърифлаб беринг. 

7. Flash MX нинг ListBox компонентини таърифлаб беринг. 

8. Flash MX нинг PushButton компонентини таърифлаб беринг. 

9. Flash MX нинг RadioButton компонентини таърифлаб беринг. 

10. Flash MX нинг ScrollBar компонентини таърифлаб беринг. 

11. Flash MX нинг ScrollPane компонентини таърифлаб беринг. 

12. ActionScript панелининг normal ва expert режимларини изоҳлаб 

беринг. 

13. Тугма учун скрипт ёзишда қандай параметрлар ишлатилади? Уларни 

изоҳлаб беринг. 

14. Кадрлар учун скриптларга мисол келтиринг. 

15. Клип учун скрипт ёзишда қандай параметрлар қўлланилади? 

16. Flash MX да сичқонча кўрсаткичини қандай қилиб пипеткага 

айлантириш мумкин? 

17. Симуляторлар учун педагогик сценарий қандай тартибда ишлаб 

чиқилади? 

18. Симуляторнинг визуал ва эмпирик моделларини таърифлаб беринг. 

19. PhET сайти симуляторларини юклаб олинг ва машқ қилинг, кейин 

унинг эмпирик моделини шакллантиринг. 

 

Фойдаланилган адабиётлар: 

1. Vera E. Using Flash. San Francisco: - Macromedia, Inc. pp. 17-22, 48-58, 169-

187, 403-411. 

2. Шишканов Д.В. Технология создания учебных мультимедиа-продуктов в 

инструментальной среде Macromedia Flash MX. Краснояр.гос.ун-т. - 

Красноярск, 2004, 215 с 

3. http://www.intuit.ru/studies/courses/2254/131/lecture 

4. https://phet.colorado.edu/ 

5. https://phet.colorado.edu/en/simulation/ph-scale-basics 

 

http://www.intuit.ru/studies/courses/2254/131/lecture
https://phet.colorado.edu/
https://phet.colorado.edu/en/simulation/ph-scale-basics
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IV. АМАЛИЙ МАШҒУЛОТ УЧУН МАТЕРИАЛЛАР 

1-амалий машғулот: Flash дастури имкониятларини ўрганиш. 

 

Ишдан мақсад: Flash дастури билан танишиш, график имкониятларни 

ўрганиш, анимацион имкониятларни ўрганиш, дастурлаш имкониятларини 

ўрганиш. 

Масаланинг қўйилиши: Тингловчи Flash MX дастурининг анимацион 

имкониятларини билиши керак. 

 

Топшириқлар: 

1. Flash MX дастурини ишга туширинг. 

2. Асбоблар палитрасида олиб борадиган фанингизга оид турли кимёвий 

идишлар ва асбоб-ускуналарни ясашни машқ қилинг. 

3. Хоссалар (properties) панелида анимация компонентларининг 

форматларини ва анимацион ҳаракатларни белгиланг. 

4. График объектларни align панелидан фойдаланиб текисланг. 

5. Вақт шкаласида оддий ва калит кадрлар қўйинг. Уларни Motion ва Shape 

усулларидан фойдаланиб анимация ясанг11. 

6. Бирор жиҳознинг деталини ҳаракатлантиришни машқ қилинг.  

7. Анимация қилинадиган деталларни алоҳида қатламларга жойлаштиринг. 

8. Кадрларга тўхтатиш ва юритиш тугмаларини жойлаб чиқинг. 

9. Қуйидаги шаклларни қисмларга ажратиб ясанг: 

 

  

   

                                                           

11 Жигалов И.Е., Озерова М.И. Мультимедиа технологии. Создание 
компьютерной анимации в Adobe Flash: Методическое пособие. Владим. гос. 
ун-т; Владимир, 2013. С. 12-32. 
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Назорат саволлари: 
 

1. Асбоблар панели қандай қисмлардан ташкил топган?  

2. Хоссалар панели нима учун хизмат қилади? Унинг ташқи кўриниши 

нимага боғлиқ?  

3. Кадрнинг (саҳнанинг) ўлчамини, фон рангини, анимация тезлигини 

(секундига кадрлар сонини) қандай қилиб ўзгартириш мумкин?  

4. Ажратиш учун қандай асбоблар қўлланилади? Объектни бутунича қандай 

қилиб ажратиш мумкин? Объектнинг бир қисмини қандай қилиб ажратиш 

мумкин?  

5. "Стрелка" шаклидаги асбоб қандай вазифани бажаради?  

6. Эркин ўзгартириш асбоби нима вазифани бажаради?  

7. Объектларга тортилиш (магнит) режими қандай ёқиб-ўчирилади?  

8. Объектларни аниқ жойлаштириш учун align панели қандай имкониятларни 

тақдим этади?  

9. "Чизиқ" асбоби ёрдамида қандай ясаш усуллари мавжуд?  

10. "Қалам" асбоби ва унинг созламалари ҳақида маълумот беринг.  
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11. "Чўтка" асбоби қандай қўшимча созламаларга эга? Улар ушбу асбобнинг 

ишлашига қандай таъсир кўрсатади?  

12. "Овал" ва "Тўғри тўртбурчак" асбоблари билан қандай объектларни ясаш 

мумкин? 

 

Фойдаланилган адабиётлар: 

1. E. Vera. Using Flash. San Francisco: - Macromedia, Inc. pp. 17-22, 48-58, 169-

187. 

2. Жигалов И.Е., Озерова М.И. Мультимедиа технологии. Создание 

компьютерной анимации в Adobe Flash: Методическое пособие. Владим. 

гос. ун-т; Владимир, 2013. С. 12-32. 

3. http://programmersclub.ru/alar-flash-lesson1/ 

 

 

 

 

  

http://programmersclub.ru/alar-flash-lesson1/
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2-амалий машғулот: Технологик фанлар бўйича анимациялар 

яратиш. 

 

Ишдан мақсад:  

Технологик фанлар бўйича анимация яратиш учун таълим 

натижаларини ифодалаш, таълим натижалари асосида сценарий ишлаб чиқиш, 

анимациялар яратиш кўникмаларини ҳосил қилиш. 

 

Масаланинг қўйилиши: Махсус фан ўқитувчиси мультимедиа 

сценарийсини ишлаб чиқиш, сценарий асосида анимациялар яратиш 

кўникмаларини эгаллаши лозим. 

 

Топшириқлар: 

1. Ўқиётган махсус фанингиз бўйича маърузада фойдаланиш учун 

анимацияни режалаштиринг. Бунинг учун берилган техник матн асосида 

мультимедиа сценарийсини ишлаб чиқинг.  

2. Анимациянинг таълим натижаларини Блум таксономияси бўйича 

ифодаланг. 

3. Сценарийни экранда режалаштиринг ва дастур интерфейсини ишлаб 

чиқинг. Дастурда қўлланиладиган навигация ва манимуляция 

амалларини режалаштиринг. 

4. Таълим натижаларига эришиш учун анимация сценарийсига 

ўзгартиришлар киритинг. 

5. Flash MX дастурининг анимацион имкониятларини ўрганинг ва қайси 

турдаги имкониятлар Сиз яратаётган анимацияда қўллаш мумкинлигини 

аниқланг12. 

6. Компонентларни Graphic, Button ва MovieClip шаклларига келтиринг. 

7. Timeline шкаласида анимация компонентларининг анимациясини Shape 

ва Motion усулларидан фойдаланиб ташкил қилинг. 

 

Назорат саволлари: 
 

1. Анимация яратишда қандай турдаги кадрлардан фойдаланилади? Улар 

қандай ҳосил қилинади? 

2. Анимациядаги турли кадрлар нимаси билан фарқланади (вақт шкаласида 

жойлашиши ва бажарадиган вазифалари бўйича)? 

3. Кадрли анимация қандай яратилади? 

4. Анимациялар яратишда қатламлар қандай вазифаларни бажаради? 

5. Қатламлар қандай ҳосил қилинади, ўчирилади ва кўчирилади?  

6. Қатламдаги контурли режим нима? 

                                                           

12 Жигалов И.Е., Озерова М.И. Мультимедиа технологии. Создание 
компьютерной анимации в Adobe Flash: Методическое пособие. Владим. гос. 
ун-т; Владимир, 2013. С. 47-79. 
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7. Шакл анимацияси қандай мақсадларда қўлланилади? 

8. Назорат нуқталари нима ва улар қандай мақсадларда қўлланилади?  

9. Назорат нуқталаридан қандай фойдаланиш керак?  

10. Тасвирларнинг трассировкаси нима, у нима учун ва қандай қилиб амалга 

оширилади?  

11. Қандай ҳолатларда трассировка амали муваффақиятсиз чиқади? 

12. Матн қандай таҳрирланади?  

13. Матнни қандай қилиб ясалган ҳарфларга айлантириш мумкин? 

14. Ҳаракат анимацияси қандай мақсадларда қўлланилади? 

15. Ҳаракат анимацияси нимаси билан шакл анимациясидан фарқ қилади? 

16. Ҳаракат анимацияси нимаси билан кадрли анимациядан фарқ қилади? 

17. Қандай объектлар учун ҳаракат анимацияси яратилади? 

18. Ҳаракат анимацияси созламалари қандай белгиланади? 

 

Фойдаланилган адабиётлар: 

 

1. E. Vera. Using Flash. San Francisco: - Macromedia, Inc. pp. 17-22, 48-58, 169-

187. 

2. Жигалов И.Е., Озерова М.И. Мультимедиа технологии. Создание 

компьютерной анимации в Adobe Flash: Методическое пособие. Владим. 

гос. ун-т; Владимир, 2013. С. 47-79. 

3. http://programmersclub.ru/alar-flash-lesson1/ 

  

http://programmersclub.ru/alar-flash-lesson1/


75 
 

3-амалий машғулот: Технологик фанлар  

бўйича симуляторлар яратиш. 

 

Ишдан мақсад: Технологик фанлар бўйича симулятор яратиш учун таълим 

натижаларини ифодалаш, интерактивликни режалаштириш ва сценарий 

ишлаб чиқиш, симуляторларни яратиш ва таҳлил қилиш кўникмаларини ҳосил 

қилиш. 

 

Масаланинг қўйилиши: Махсус фан ўқитувчиси симулятор сценарийсини 

ярата билиши, мавжуд симуляторларни баҳолай олиши зарур. 

 

Топшириқлар: 

1-турдаги топшириқ: Симулятор яратиш 

1. Симулятор яратиш учун ўзингиз олиб борадиган фаннинг амалий ёки 

лаборатория машғулоти мавзусини танланг. 

2. Симуляторнинг мақсадини ва Блум таксономияси бўйича таълим 

натижаларини режалаштиринг. 

3. Мавзудаги инструментал характерга эга бўлган фрагментнинг визуал 

моделини режалаштиринг. Симулятор интерфейсини ишлаб чиқинг. 

4. Мавзудаги инструментал характерга эга бўлган фрагментнинг эмпирик 

моделини режалаштиринг. Симулятордаги ўзгарувчиларни белгиланг. 

5. Симуляторнинг интерфаолликни таъминловчи Graphic, Button, MovieClip, 

CheckBox, ComboBox, ListBox, PushButton, RadioButton, ScrollBar, 

ScrollPane каби компонентларини алоҳида тайёрланг. 

6. Flash MX дастурида симуляторни йиғинг ва ишлашини текширинг. 

 

2-турдаги топшириқ: Симуляторни таҳлил қилиш 

 

7. PhET сайтидаги https://phet.colorado.edu/en/simulation/acid-base-solutions  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

8. PhET сайтидаги https://phet.colorado.edu/en/simulation/ph-scale  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

9. PhET сайтидаги https://phet.colorado.edu/en/simulation/atomic-interactions 

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

10. PhET сайтидаги https://phet.colorado.edu/en/simulation/legacy/lasers  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

11. PhET сайтидаги https://phet.colorado.edu/en/simulation/states-of-matter-

basics  симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

12. PhET сайтидаги https://phet.colorado.edu/en/simulation/states-of-matter  

https://phet.colorado.edu/en/simulation/acid-base-solutions
https://phet.colorado.edu/en/simulation/ph-scale
https://phet.colorado.edu/en/simulation/atomic-interactions
https://phet.colorado.edu/en/simulation/legacy/lasers
https://phet.colorado.edu/en/simulation/states-of-matter-basics
https://phet.colorado.edu/en/simulation/states-of-matter-basics
https://phet.colorado.edu/en/simulation/states-of-matter
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симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

13. PhET сайтидаги https://phet.colorado.edu/en/simulation/molecule-polarity   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

14. PhET сайтидаги https://phet.colorado.edu/en/simulation/molecules-and-light   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

15. PhET сайтидаги https://phet.colorado.edu/en/simulation/molecule-shapes   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

16. PhET сайтидаги https://phet.colorado.edu/en/simulation/molecule-shapes-

basics   симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

17. PhET сайтидаги https://phet.colorado.edu/en/simulation/build-an-atom    

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

18. PhET сайтидаги https://phet.colorado.edu/en/simulation/rutherford-scattering   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

19. PhET сайтидаги https://phet.colorado.edu/en/simulation/legacy/band-structure   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

20. PhET сайтидаги https://phet.colorado.edu/en/simulation/concentration   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 

3-турдаги топшириқ: Интерфаол элементлар яратиш13 

 

21. MovieClip элементларидан 4 тасини ишлаб чиқинг (mc1, mc2, mc3, mc4). 

Button элементини яратинг ва унга қуйидаги скриптни ёзинг: 

on(release) { 

 switch (vv) { 

  case "mc1": gotoAndPlay("mc1"); break; 

  case "mc2": gotoAndPlay("mc2"); break; 

  case "mc3": gotoAndPlay("mc3"); break; 

  case "mc4": gotoAndPlay("mc4"); break; 

   default: trace ("Xato"); break; 

 } 

} 

 

22. Button элементидан 6 тасини ясанг (b1, b2, b3, b4, b5, b6). Ҳар бир тугмага 

                                                           
13 Копеев Ж.Б., Нургазинова Г.Ш. Сборник практических работ по Macromedia Flash. Учебно-методическое 
пособие. - Павлодар, Научный издательский центр ПГПИ, 2011, с.94. 

https://phet.colorado.edu/en/simulation/molecule-polarity
https://phet.colorado.edu/en/simulation/molecules-and-light
https://phet.colorado.edu/en/simulation/molecule-shapes
https://phet.colorado.edu/en/simulation/molecule-shapes-basics
https://phet.colorado.edu/en/simulation/molecule-shapes-basics
https://phet.colorado.edu/en/simulation/build-an-atom
https://phet.colorado.edu/en/simulation/rutherford-scattering
https://phet.colorado.edu/en/simulation/legacy/band-structure
https://phet.colorado.edu/en/simulation/concentration
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қуйидаги скриптни ёзинг: 

on(press) { 

 startDrag ("b1", true); 

} 

on (release) { 

 stopDrag (); 

} 

 

Саҳнага dinamic text объектини ("matn" номи билан) ясанг. Button 

элементи ясанг ("tekshirish") номи билан. Унга қуйидаги скриптни ёзинг: 

on(release) { 

 if (b1._x<150& b2._x<150& 

b4._x<150& b3._x>390& b6._x>390& 

b5.x>390) 

 {matn="To'g'ri"} 

 Else {matn="Noto'g'ri";} 

} 

Симуляторнинг ишлашини текширинг. Тугмаларни экранда кўчиринг 

ва керакли жойга жойлаштиринг. 

 

 

Фойдаланилган адабиётлар: 

1. E. Vera. Using Flash. San Francisco: - Macromedia, Inc. pp. 17-22, 48-58, 

169-187. 

2. Копеев Ж.Б., Нургазинова Г.Ш. Сборник практических работ по 

Macromedia Flash. Учебно-методическое пособие. - Павлодар, Научный 

издательский центр ПГПИ, 2011, с.94. 

3. http://programmersclub.ru/alar-flash-lesson1/ 

4. https://phet.colorado.edu/en/simulation/acid-base-solutions 

5. https://phet.colorado.edu/en/simulation/ph-scale 

6. https://phet.colorado.edu/en/simulation/atomic-interactions 

7. https://phet.colorado.edu/en/simulation/legacy/lasers 

8.  https://phet.colorado.edu/en/simulation/states-of-matter-basics 

9. https://phet.colorado.edu/en/simulation/states-of-matter 

10. https://phet.colorado.edu/en/simulation/molecule-polarity 

11. https://phet.colorado.edu/en/simulation/molecules-and-light   

12. https://phet.colorado.edu/en/simulation/molecule-shapes 

13. https://phet.colorado.edu/en/simulation/molecule-shapes-basics 

14. https://phet.colorado.edu/en/simulation/build-an-atom 

15. https://phet.colorado.edu/en/simulation/rutherford-scattering 

16.  https://phet.colorado.edu/en/simulation/legacy/band-structure 

17. https://phet.colorado.edu/en/simulation/concentration 
 

  

http://programmersclub.ru/alar-flash-lesson1/
https://phet.colorado.edu/en/simulation/acid-base-solutions
https://phet.colorado.edu/en/simulation/ph-scale
https://phet.colorado.edu/en/simulation/atomic-interactions
https://phet.colorado.edu/en/simulation/legacy/lasers
https://phet.colorado.edu/en/simulation/states-of-matter-basics
https://phet.colorado.edu/en/simulation/states-of-matter
https://phet.colorado.edu/en/simulation/molecule-polarity
https://phet.colorado.edu/en/simulation/molecules-and-light
https://phet.colorado.edu/en/simulation/molecule-shapes
https://phet.colorado.edu/en/simulation/molecule-shapes-basics
https://phet.colorado.edu/en/simulation/build-an-atom
https://phet.colorado.edu/en/simulation/rutherford-scattering
https://phet.colorado.edu/en/simulation/legacy/band-structure
https://phet.colorado.edu/en/simulation/concentration
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V. КЕЙСЛАР БАНКИ 

Flash MX дастурида виртуал стенд ишлаб чиқиш жараёнида 

скриптда хатолик рўй берди. Яъни дастур тўлиқ ишламади. 

Муаммони ҳал қилинг. 

 

 
 

Macromedia Flash dasturida анимацион ролик ишга тушганда 

экран тўлиқ режимда очилиши зарур. Бунга эришиш учун 

Properties/Action-Frame бандидаги "+/Actions/Browser-

Network/fscommand(...)" командаси қўйилганидан кейин 

қавс ичига нуқталар ўрнига команданинг параметрларни 

ёзиш керак. Бироқ, параметрлар хотирамиздан кўтарилган ва 

қўлимизда ҳеч бир қоғоздаги маълумотнома мавжуд эмас. 

Муаммони қандай ҳал қилиш мумкин. 

 

 

 
 

• Кейсдаги муаммони келтириб чиқарган асосий сабабларни
белгиланг, зарур билимлар рўйхатини тузинг (индивидуал ва
кичик гуруҳда).

• Дастурдаги хатоликни йўқотиш учун бажариладагина ишлар
кетма-кетлигини белгиланг (жуфтликда ишлаш).

• Хатоликни тузатинг ва дастурни ишга туширинг.

• Бажарилган ишларни тақдимот қилинг.

Кейсни бажариш босқичлари ва топшириқлар:

Кейсдаги муаммони ечиш учун Macromedia Flash 
маълумотномасини кўздан кечиринг (якка тартибда).

•Macromedia Flash командалари рўйхатидан фойдаланинг
(жуфтликда ишлаш).

•Олдин тузилган дастур скриптларини кўздан кечиринг ва
улардан нусҳа олинг.

•Дастур туза оладиган танишларингиздан маслаҳат олинг.

•Кейинги сафар эсдан чиқиб қолмаслиги учун команда
параметрларини ассоциация қилиб хотирага мустаҳкамланг.

•Параметрларни қўйинг ва дастурни ишга туширинг. Бажарилган
ишларни тақдимот қилинг.

1-кейс 

2-кейс 

Кейсни бажариш босқичлари ва топшириқлар: 
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Махсус фан бўйича виртуал лаборатория мультимедиа 

ишланмасини ишлаб чиқиш керак. Бироқ дастурчи аввал 

нимани, қандай қилиб ясаш кераклигини, мультимедианинг 

сценарийсини тузиб беришни илтимос қилди. Муаммони 

ҳал қилинг. 

 

 

 

 
 

  

•Мультимедиа материалини чуқур
ўрганиб чиқинг. (якка тартибда).

•Таълим натижаларини белгилаб олинг
(гуруҳда).

•Зарур график материалларни тўпланг

•Анимация ва навигация турларини
белгиланг.

•Мос мультимедиа дастурини танланг.

•Виртуал стенд сценарийсини тузинг
(якка тартибда).

•Амалга оширилган ишларни тақдимот
қилинг.

3-кейс 

Кейсни бажариш босқичлари ва топшириқлар: 
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Махсус фан ўқитувчиси анимацион ролик ишлаш учун 

Macromedia Flash MX дастурини танламоқчи. Унга 

PowerPoint имкониятларини кўрсатиб, ўқитувчини ишни тез 

ва осон бажаришга кўндиринг. 

 

Кейсни бажариш босқичлари ва топшириқлар: 

 
 

 

1. Мультимедиа материалини чуқур ўрганиб чиқинг  (якка тартибда).

2. Ўқитувчининг дарс режасини ва маъруза дарсининг таълим 
натижаларини аниқланг (жуфтликда).

3. Таълим натижаларига эришиш учун мавжуд матнли ва 
график материалларни сараланг (гуруҳда).

4. Таълим натижаларига эришиш учун анимацияларни 
режалаштиринг, уларни саралаб гуруҳларга ажратинг.

5. Ҳар бир гуруҳ анимациялари ва навигацияларини амалга 
ошириш учун PowerPoint нинг анимация турлари, бошқарув 
элементлари, овоз ва видео ёзиш, экрандан нусҳа олиш, 
экрандан видеотасвирни ёзиш, шакллар қўйиш, гипермурожаат,  
слайддан-слайдга ўтиш эффектлари, слайд-шоу ёзиш ва 
iSpring Pro иловасидан флеш-анимация, интерфаол тестлар, 
интерфаоллик ва YouTube қўйиш имкониятларидан мосини 
танланг (гуруҳда). 

6. Ўқитувчига танланган имкониятларни намойиш қилинг, 
эътирозларни кўриб чиқинг ва Macromedia Flash MX да ишланадиган 
ишлаб айрим мураккаб элементларни ажратинг ва экспорт қилиш 
мумкинлигини кўрсатинг (жуфтликда).

7. Амалга оширилган ишларни тақдимот қилинг.

4-кейс 
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Ассесмент топшириқлари 

Ассесмент топшириқлари 4 қисмдан иборат бўлади: кейс-стади, 

тушунча таҳлили, қиёсий таҳлил, амалий топшириқ. Тестлар алоҳида электрон 

шаклда алоҳида файлда тақдим этилади. Қуйида ассесмент топшириқларининг 

тушунча таҳлили, қиёсий таҳлил ва амалий кўникмалар қисмлари 

келтирилган. 

 

Тушунча таҳлили бўйича саволлар: 

 Flash MX - бу ... 

 Мультимедиа - бу ... 

 Видеоролик- бу ... 

 Виртуал стенд - бу ... 

 Анимация - бу ... 

 Мультимедиа сценарийси - бу ... 

 FLA-файл - бу ... 

 SWF-файл - бу ... 

 EXE-файл - бу ... 

 ActionScript - бу ... 

 Растрли ва векторли графика - бу ... 

 Кадрли анимация - бу ... 

 Шакл анимацияси - бу ... 

 Навигация элементлари - бу ... 

 Таълим натижалари - бу ... 

 Graphic symbol - бу ... 

 Button - бу ... 

 MovieClip - бу ... 

 Instance - бу ... 

 Symbol properties - бу ... 

 CheckBox - бу ... 

 ComboBox - бу ... 

 ListBox - бу ... 

 PushButton - бу ... 

 RadioButton - бу ... 

 ScrollBar - бу ... 

 ScrollPane - бу ... 

 ActionScript - бу ... 

 onClipEvent - бу ... 

 PhET - бу ... 

 Визуал модель - бу ... 

 Эмпирик модель - бу ... 

  



82 
 

 

Қиёсий таҳлил бўйича саволлар: 

 Macromedia Flash MX ва Adobe Flash ларни график органайзерлар 

воситасида таққосланг. 

 Мультимедиа ва мультимедиа сценарийси тушунчаларини график 

органайзерлар воситасида таққосланг. 

 Видеоролик ва виртуал стенд тушунчаларини график органайзерлар 

воситасида таққосланг. 

 FLA, SWF, EXE файлларни график органайзерлар воситасида 

таққосланг. 

 Растрли ва векторли графикани график органайзерлар воситасида 

таққосланг. 

 Кадрли анимация, шакл анимацияси ва ҳаракат анимацияларини 

график органайзерлар воситасида таққосланг. 

 Навигация элементларига мисоллар келтиринг ва уларни график 

органайзерлар воситасида таққосланг. 

 Graphic, Button, MovieClip элементларини график органайзерлар 

воситасида таққосланг. 

 CheckBox, ComboBox, ListBox компонентларини график органайзерлар 

воситасида таққосланг. 

 PushButton, RadioButton компонентларини график органайзерлар 

воситасида таққосланг. 

 ScrollBar, ScrollPane компонентларини график органайзерлар 

воситасида таққосланг. 

 Визуал ва эмпирик модель тушунчаларини график органайзерлар 

воситасида таққосланг. 

 

Амалий топшириқлар бўйича саволлар: 

 Қуйидаги расмлардан бирини қисмларга ажратиб ясанг: 
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 Қуйидаги расмлардан бирини қисмларга ажратиб ясанг. Ҳар бир қисмни 

алоҳида қатламга жойлаштиринг. Анимацион ҳаракатларни ясанг. 

 

    
 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/acid-base-solutions  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/ph-scale  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/atomic-interactions 

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/legacy/lasers  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/states-of-matter-

basics  симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/states-of-matter  

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/molecule-polarity   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/molecules-and-

light   симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/molecule-shapes   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/molecule-shapes-

basics   симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/build-an-atom    

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/rutherford-

https://phet.colorado.edu/en/simulation/acid-base-solutions
https://phet.colorado.edu/en/simulation/ph-scale
https://phet.colorado.edu/en/simulation/atomic-interactions
https://phet.colorado.edu/en/simulation/legacy/lasers
https://phet.colorado.edu/en/simulation/states-of-matter-basics
https://phet.colorado.edu/en/simulation/states-of-matter-basics
https://phet.colorado.edu/en/simulation/states-of-matter
https://phet.colorado.edu/en/simulation/molecule-polarity
https://phet.colorado.edu/en/simulation/molecules-and-light
https://phet.colorado.edu/en/simulation/molecules-and-light
https://phet.colorado.edu/en/simulation/molecule-shapes
https://phet.colorado.edu/en/simulation/molecule-shapes-basics
https://phet.colorado.edu/en/simulation/molecule-shapes-basics
https://phet.colorado.edu/en/simulation/build-an-atom
https://phet.colorado.edu/en/simulation/rutherford-scattering


84 
 

scattering   симуляторнинг эмпирик моделини тузинг ва уни схематик 

тарзда ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/legacy/band-

structure   симуляторнинг эмпирик моделини тузинг ва уни схематик 

тарзда ифодаланг. 

 PhET сайтидаги https://phet.colorado.edu/en/simulation/concentration   

симуляторнинг эмпирик моделини тузинг ва уни схематик тарзда 

ифодаланг. 

 

 

  

https://phet.colorado.edu/en/simulation/rutherford-scattering
https://phet.colorado.edu/en/simulation/legacy/band-structure
https://phet.colorado.edu/en/simulation/legacy/band-structure
https://phet.colorado.edu/en/simulation/concentration
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VI. МУСТАҚИЛ ТАЪЛИМ МАВЗУЛАРИ 

Мустақил таълимни ташкил этишнинг шакли ва мазмуни 

 

Мустақил таълим тегишли ўқув модули бўйича ишлаб чиқилган 

топшириқлар асосида ташкил этилади ва унинг натижасида тингловчилар 

битирув иши (лойиҳа иши) ни тайёрлайди.  

Тингловчилар анимацияларни яратиш бўйича Macromedia Flash 

дастурининг имкониятларини ўрганишади. Macromedia Flash дастурида 

виртуал стендлар яратиш имкониятларини ўрганишади. 

Битирув иши (лойиҳа иши) талаблари доирасида ҳар бир тингловчи ўзи 

дарс бераётган фани бўйича электрон ўқув модулларининг тақдимотини 

тайёрлайди, бунда албатта iSpring дастурида тайёрланган интерфаол тестлар, 

MS Excel да тайёрланган ҳисоблаш дастури, Macromedia Flash дастурларида 

яратилган анимация ёки виртуал стендлар бўлиши зарур. 

Ҳар бир тингловчи битирув иши (лойиҳа иши) доирасида ўзи дарс 

бераётган фани бўйича MOODLE тизими учун ишлаб чиққан ўқув 

контентларини шакллантириши ва уларнинг тақдимотини қилиши керак 

бўлади.  

Ишлаб чиқилган ўқув модулларида фанни ўзлаштиришга ёрдам берувчи 

қўшимча материаллар: электрон таълим ресурслари, маъруза матни, видео 

ресурслар, глоссарий, тест, кроссвордлари ва бошқалар мавжуд бўлиши 

мумкин. Бу материалларни соҳа бўйича оммавий онлайн очиқ курсларидан 

олиш тавсия этилади. 

 

Мустақил таълим мавзулари: 

 

1. Moodle платформасида ўқув курсларини шакллантириш 

имкониятларини https://www.udemy.com/moodlefree/learn/  (Moodle 2 для 

новичков) орқали ўрганинг. 

2. Махсус фан бўйича ўқув материаллари асосида мультимедиа учун 

мультимедиа сценарийсини ишлаб чиқинг. 

3. Махсус фан бўйича Moodle тизими учун маъруза материаллари ва тест 

саволларини тайёрланг. 

4. Махсус фан бўйича Moodle тизими учун амалий машғулот 

материалларини ва топшириқларини тайёрланг. 

5. Махсус фан бўйича Moodle тизими учун лаборатория машғулоти 

материалларини тайёрланг. 

6. Битирув иши (лойиҳа иши) талаблари доирасида ўзингиз дарс бераётган 

фан бўйича электрон ўқув модулларининг тақдимотини тайёрланг.  

7. iSpring дастурида интерфаол тестларни тайёрланг. 

8. MS Excel да махсус фан бўйича ҳисоблаш дастурини ишлаб чиқинг. 

9. Macromedia Flash дастурларида махсус фан бўйича анимация яратинг. 

10. Macromedia Flashдастурларида махсус фан бўйича виртуал стендлар 

яратинг.  

https://www.udemy.com/moodlefree/learn/
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VII. ГЛОССАРИЙ 

 

Термин Ўзбек тилидаги шарҳи Инглиз тилидаги шарҳи 

Анимация 

Динамик ва овозли 

жараëнларни ифодалашга 

имкон берадиган график 

ахборотларни ташкил этиш 

усули 

The way of the organization of 

graphic information allowing to 

reproduce dynamic and sound 

processes 

Мультимедиа 

сценарийси 

ActionScript тилида ёзилган 

скрипт 

Script, which writen in 

ActionScript language. 

FLA-файл 

Flash дастурининг асл 

файли. Унда барча 

маълумотлар сақланади. 

Унинг асосида бошқа 

файлларни ташкил қилиш 

мумкин. 

Original file, that allow to keep 

all data. In its based can be 

organized other files. 

SWF-файл 

Flash дастурининг 

бажарилувчи файли. Унинг 

бажарилиши учун 

FlashPlayer дастури зарур 

бўлади. 

Used file of program Flash. It 

require FlashPlayer for using. 

EXE-файл 

Flash дастурининг 

бажарилувчи файли. У 

Windows тизимида ҳеч 

қандай плеерсиз 

бажарилади. 

Used file of program Flash. It 

do not require any FlashPlayer 

for using. 

Виртуал 

лаборатория 

Ҳақиқий объектларда 

бўлаëтган жараëнларни 

компьютер имитацияси 

орқали тақдим этиш ва 

масофавий кириш 

имкониятига эга бўлган 

дастурий мажмуа 

Software allowing to present 

processes in true objects in the 

way of computer imitation and 

a remote entrance 

Интерактив 

ўқув курслари 

Ўзаро мулоқот асосига 

қурилган воситалардан 

фойдаланиб тузилган 

курслар 

The courses made by use of 

means of mutual 

communication 

Контент 

Курснинг барча ўқув 

материаллари, 

қўлланмалари, ҳужжатлари, 

вазифалари, тестлар ва 

назорат метериалларини 

The maintenance of a course, 

covering all training materials, 

grants, documents, tasks, tests 

and control questions 
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қамраб олувчи курс мазмуни 

Мультимедиа 

Ахборотни (матн, расм, 

анимация, аудио, видео) 

ифодалашнинг кўп 

имкониятли тақдим 

этилиши 

Multipurpose submission of 

information (text, graphics, 

animation, video) 

Электрон 

дарслик 

Компьютер технология-

ларига асосланган ўқитиш 

методларидан фойдаланиш-

га мўлжалланган ўқитиш 

воситаси 

The tutorial intended for use of 

methods of training based on 

computer technologies 

ActionScript 

Flash дастурининг 

скриптлар ёзиш учун 

мўлжалланган алгоритмик 

тили 

Algoritmic language consigned 

for writing scripts of sotfware 

Flash. 

Растрли 

графика 

Нуқталардан таркиб топган 

графика. Ҳар бир нуқта 

алоҳида ранг ва тусга эга. 

Катта ҳажмни эгаллайди. 

Graphic element, which include 

many points. Each of point 

have own color. This file 

requires much of places. 

Векторли 

графика 

Дастурли усулда нуқта, 

чизиқ ва шакл сифатида 

ясаладиган графика. Кам 

ҳажмни эгаллайди. Лекин 

компьютер процессорини 

зўриқтиради. 

Graphic element, which include 

vectorial objects, as point, line 

and shape. This file do not 

requires much of places. But, it 

very load processor of 

computer. 

Кадрли 

анимация 

Ҳар бир кадри ясаб 

чиқиладиган классик 

анамация. 

Classic animation, in which 

each frame is drawn separately. 

Шакл 

анимацияси 

Векторли график 

элементнинг ўзгаришини 

ифодаловчи анимация. 

Animation, which shows 

changes in the elements of 

vector graphics. 

Ҳаракат 

анимацияси 

Graphic ёки гуруҳланган 

объектларнинг ҳолатини 

ўзгартириш усули. 

Animation, in which changes of 

states of graphic or grouped 

objects. 

Навигация 

элементлари 

Бошқарув элементлари - 

клавиатура тугмаси, 

сичқонча тугмаларининг 

босилиши ва ҳ.к. 

Management elements - key 

buttons, buttons of mouse and 

etc. 

Graphic 

symbol 

Статик расм. Унинг ичида 

растрли ёки векторли 

графика бўлиши мумкин. 

Static picture. Can include 

raster or vektorial graphic. 

Button-symbol 

Интерфаол тугма. У одатда 

статик бўлади. Динамик 

тугма ўз ичига MovieClip 

Interactive button. Usually have 

been in static state. Dinamical 

button, also can include 



88 
 

объектини ҳам олиши 

мумкин. 

MovieClip object. 

MovieClip-

symbol 

Анимацион ҳаракатлардан 

иборат объект. Уни бошқа 

MovieClip ичига, ёки тугма 

ичига жойлаштириш ҳам 

мумкин. 

Object, which consist of 

animation moves. It can be 

placed in other MovieClip and 

Button object. 

CheckBox Жавоб байроқча билан 

белгиланадиган интерфаол 

майдон. 

Interactive field, in which 

checks right answers in boxes. 

ComboBox Тушириб очиладиган 

рўйхатдан битта жавобни 

танлаш учун интерфаол 

майдонча. 

Interactive field, that is openIng 

with down-knob, in which 

selects only one answer. 

ListBox Очиқ рўйхат шаклида бўлиб 

бир ёки кўп бандларни 

танлаш имконини берадиган 

интерфаол майдон. 

Interactive field, that presented 

in open list, which allows to 

select one or more answers. 

PushButton Flash-роликка оддий 

тугмаларни қўшишга имкон 

берадиган интерфаол тугма. 

Interactive button, which allows 

to add simple buttons for Flash-

simulation. 

RadioButton Радиотугмаларни Flash 

ҳужжатига қўшишга имкон 

берадиган интерфаол тугма. 

Interactive button, which allows 

to add radio-knobs for Flash-

simulation. 

ScrollBar Катта матнга вертикал ва 

горизонтал айлантириш 

полосаларини 

жойлаштирувчи ва улар 

орқали матнни экранда 

кўрсатадиган интерфаол 

майдон 

Interactive field, which allows 

to add horizontal and vertical 

scroll bar for big text and can 

show in screen all of the text. 

ScrollPane Флеш-роликларда вертикал 

ва горизонтал полосали 

ойналар қўшувчи интерфаол 

майдон. 

Interactive window, which 

allows to add horizontal and 

vertical scroll pane to Flash-

simulations. 

Визуал модель Мультимедиа дастурининг 

интерфейсини ифодаловчи 

педагогик модель 

Pedagogical model, which 

shows interface of multimedia 

software. 

Эмпирик 

модель 

Мультимедиа дастурининг 

ички боғлиқликларини 

ифодаловчи педагогик 

модель 

Pedagogical model, which 

shows inside communications 

of multimedia software. 
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VIII. АДАБИЁТЛАР РЎЙХАТИ 

Махсус адабиётлар: 

 

1. Vere E. and etc. Using Flash. San Francisco: - Macromedia, Inc. 2002, p. 438. 

2. Корсаро С. Мультипликация и Flash. – Пер. с англ. – СПб Символ-Плюс. 

2008. 240 с. 

3.  Andersen B.B., Brink K. Multimedia in Education. – UNESCO IITE, Moscow 

2013, p. 141. 

4. Бегимқулов У.Ш. Замонавий ахборот технологиялари муҳитида педагогик 

таълимни ташкил этиш.// “Педагогик таълим” жур, № 1, 2004.–25-25 

бетлар.  

5. Бегимқулов У.Ш. Малака ошириш тизимида замонавий ахборот 

технологияларидан фойдаланиш. //”Халк таълими” жур. № 6, 2004. - 132-

137 бетлар.  

6. Бегимқулов У.Ш. Малака ошириш тизимида замонавий ахборот 

технологияларидан фойдаланиш. //”Халк таълими” жур. № 6, 2004.-132-

137 бетлар.  

7. Андерсен, Бент Б. Мультимедиа в образовании / Бент Б. Андерсен, Катя 

ван ден Бринк – М. : Дрофа, 2007. – 224 с.  

8. Вовк Е. Т. Информатика: уроки по Flash.— М.: КУДИЦ-ОБРАЗ, 2005. — 

176 с.  

9. В.С.Хамидов, Д.А.Собирова. «Таълимда мультимедиа тизимлари ва 

масофавий ўқитиш методлари» модули бўйича ўқув–услубий мажмуа. 

Олий таълим тизими педагог ва раҳбар кадрларини қайта тайёрлаш ва 

уларнинг малакасини оширишни ташкил этиш бош илмий-методик 

маркази. Тошкент-2015 й. 64 б. 

10. Сабирова Д.А. Мультимедиа тизимлари ва технологиялари. Ўқув қулланма 

-Т: ТГЭУ, 2013 й.  

 

Интернет ресурслари: 

 

1. http://programmersclub.ru/alar-flash-lesson1/ 

2. http://www.filebox.ru/p/flash_mx/ 

3. https://www.bloopanimation.com/flash-animation 

 

http://programmersclub.ru/alar-flash-lesson1/
http://www.filebox.ru/p/flash_mx/
https://www.bloopanimation.com/flash-animation

